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Login page consists of the central main area and the upper banner. In the right half of the 

central main area, you can enter your account and password to login the platform which you 

choose. You can get the current version under the WebAcccess/SCADA title if necessary. We 

provide downloads of related application on the upper banner.


Select Project Management on platform.





1. Login Page


Login to Project Management


Note - SaaS Composer and WISE-PaaS Dashboard option appears when specified application

 is installed.
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Enter your account and password.
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If you want to remember your account on your browser, please tick the Remember me option.
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An error message appears when your account or password is incorrect.
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Select Realtime Monitoring on platform, then push GO. You will see the Realtime Monitoring 

page.


Enter Realtime Monitoring
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You can download applications contains WebAccess Client, SUSI Server Installer, HTTPS 

SSL/TLS Certificate and WebAccess Android APP.


Download Related Applications
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Project List is an overview of Project and SCADA node.


2. Project List (Home Page)
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Click right-top plus icon，you can open the Create New Project dialog.

Add New Project


Delete Project
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Click checkbox in project block，and then click right-top delete icon，you can delete the 

project.

It can open SCADA Node Block by click right arrow icon.

Click left Edit icon to open edit dialog.

Expand SCADA Node


Edit Project / SCADA Node basic info
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You can click any project name you want to see detail info，then you will go to the project 

organization chart for advanced configuration.


Go to Project Manager
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1. From Project List(2. Project List) select your Project Name.


2. The Advantech WebAccess/SCADA Project Manager opens (Organization chart)


3. Select New Node in the Insert button


3. Getting Started

3.1 Project Manager

3.1.1 Add SCADA Node
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4. The Create New SCADA Node dialog opens


5. Enter a Primary Node Name for this SCADA node. This is the name that users will see in the 

caption bar og VIEW and use to select this node from a list of nodes if you have multiple 

SCADA nodes.
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6. Optionally, enter a Description.


  7. Enter the SCADA Node IP  address of the SCADA node.  The Project Node IP Address 

appears by   


     default.  Be sure to enter the IP Address of the SCADA node. You can also use a  URL or 

Computer 


      Name.


  8. If connecting through a  Firewall, enter the Primary TCP Port of a TCP port assigned by your  

system 


     administrator.  


     If not using a Firewall, accept  the default: 0.  Note that 0 means the default primary port 

number (4592)


  9.   If connecting through a  Firewall, enter the Secondary TCP Port of a TCP port assigned by 

your  system 


       administrator.


      If not using a Firewall, accept  the default: 0.  


      Note that 0 means the default secondary port number (14592).


  10.  It is recommended to accept  the default Node Time Out.  0 means the default value is 

used 


        (15  seconds).  SCADA Node Time out can range from 1 to 60 seconds. 


        This is the time  for normal communications between the SCADA Node and a VIEW Client, 

the Project   


        Node and the ASP Server. 


        If you have a very slow network connection between the  Project and SCADA nodes, you 

may have to 


        increase this value.


  11.  Enter the Remote Access  Code for the SCADA node entered during software installation 

of the 


        SCADA  node software. The Project Nodes Remote Access Code appears by default. The  

SCADA Node 


         and Project Node do not necessarily have the same Access Code.  This  Remote Access 

Code is to 


         prevent unauthorized use of your SCADA node. This code  was established when the 

SCADA Node  


         software was installed.


  12.  Leave the information  about Alarm Log, Printers, Action Log, Alarm Beep, email and other 

fields 


         blank  for now.


  13.   Most users should leave  the information under Redundant SCADA node blank. If you have 

a 
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         Redundant SCADA  Node, enter its IP address, node name, firewall ports and remote 

access  code.


  14.  Press Submit.


1. Select your SCADA node under the Project node.

2. Select  Comport in the Insert button.

3. Select the TCP/IP as the Interface Name for this Comport. (Also called the Comport Type).


      The fields change depending on the Comport type.

3.1.2 Add Comport
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4. The TCP/IP Comport Properties page appears.
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    TCPIP - TCP/IP (transmission Control Protocol /  Internet Protocol). Specifies a "Virtual Port" 

that uses the   


    TCP/IP service  installed.  Does not correspond to specific IO card or comport number.  Will  

access any IO 


    card that uses the TCP/IP service installed on your PC.


   5. Enter a Comport Number. It is recommended  to use a number above 2 so you don't 

interfere with 


       adding a serial comport.   Most PCs have 2 serial comports, if you configured a TCP/IP 

comport as 1 or 2,  
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       you would not be able to use that serial comport in the future. It is not easy  to change 

comport 


       numbers.


6. Optionally, enter a Description. This is just for your own reference.


  7. Enter  a Scan Time and select the radio button for the units (Millisecond,  Second, Minute or 

Hour).  


     All devices are scanned at the  same frequency on a given comport. All Constant  Scan type 

Tags are 


     scanned at the same frequency on a comport. Display Scan Tags are scanned at this same  

frequency, but 


     only when they appears on a Display. 


  8. Accept  the default values for the other fields, or modify them. For a description of  the data 

entry fields 


     for a TCP/IP Network Interface see, section 3.3.4 TCP/IP Com Port  Properties.


  9. Click Submit.


1. Click on the Port1(TCPIP) which is created in the previous section 3.1.2.


2. Click on the Insert button.


3.1.3 Add Device


https://www.yuque.com/__workers/webaccess-scada/user/project-management/4.2.6_Scan_Type.htm
https://www.yuque.com/__workers/webaccess-scada/user/project-management/4.2.6_Scan_Type.htm
https://www.yuque.com/__workers/webaccess-scada/user/project-management/3.3.4_TCP_IP_Com_Port_Properties.htm
https://www.yuque.com/__workers/webaccess-scada/user/project-management/3.3.4_TCP_IP_Com_Port_Properties.htm
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3. The Create New Device dialog opens.
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4. Select Modicon from the Device Type pull down list.
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5. Enter a Device Name. 


6. Optionally enter a description.


7.  Enter the Unit Number. This  number will appear in VIEW during runtime on the Station 

Status display and will  be the reference to Enable and Disable communications to the 

Device. It also  will be the reference for communication alarms. (1 to 254)


      Logically, this usually  matched the actual device number, but it is possible to assign a unit 

number for    
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      VIEW users which does not match the actual Modbus Protocol Device Address. For  example, 

each 

      Modbus PLC has a unique IP Address and all PLCs have  Modbus  Device address of 1 at 

these unique IP   


      Addresses.


8. Enter an IP Address for the  Device.


9. Enter the TCP or UDP Port Number  for the Device.  


10. Enter a Device Address if  different from the Unit Number.


11. Optionally add Address and Port information for a redundant communication path  to the 
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Device. For example, if the PLC has two Network Interface Cards (NICs).


12. If using TCP (the official Modbus Ethernet protocol) leave 0 for Use UDP.


13. Press Submit.  This can be a wait  while datatables are created on the Project Node.


1. Click on the device node which is created in the previous section 3.1.3.


2. Select Add Tag in the Insert button.


3. The Create New Tag dialog opens.


4. Select the AI Parameter from the Parameter Pull Down List.


5.  The AI Parameter Page opens.


3.1.4 Add Tag
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6. Select DO from the Parameter Pull  Down List (you have to scroll down to the bottom of the 

list.
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This section assumes you have already created the BLOCK TYPE you plan to use to act as a 

template for your Block Tag. Please refer to Add a Block Type section for information about 

building a Block Type Template.


This section also assumes you have configured a Comport and a Device.  Please refer to 

Configure a Communication Port and Device Configuration for information on creating a 

Comport or Device.


This section assumes you have started Internet Explorer Web Browser and connected to your 

Project Node.


3.1.5 Block Configuration

Add Block
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1. Focus on your Device.


2. Press Insert button and select Add Block.





3. Select the Block Type from pull down list.


4. Enter a Block Name.  This will become the Tag name for your Block Tag.  Block Name is up 
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12 alphanumeric characters. This is the name that users and operators will use to access the 

data read by this tag.   Typical Block Names are TIC1001, Zone11, and Pump61.


5. Enter an Offset.  If you planned your addresses well, you will be able to use the Block Offset 

feature to create the proper addresses for all the parameters in the block with a single 

keystroke.


6. The offset may be as simple as an integer or may be a complex series of numbers, commas 

and letters. Refer to your specific device driver guide for the addresses used by your device.


7. The Block Offset feature will increment all the addresses of all the parameters in a block by 

a given amount. If your parameter addresses have a predictable pattern, the Block Offset 

feature can greatly reduce the time and effort to create blocks and establish 

communications with the field.


8. Press Submit when finished.


1. Click Block which you want to edit.


Delete Block
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2. You will see the Block List page.


3. Select blocks which you want to delete.


4. Press Delete button on the above bar.


1. Enter Block List.

Configure Block Tags
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2. Click the block name.


3. You will enter Block Tag


4. Choose the tag and click Edit, you can edit the configuration.


From the Project Manager, Project Users can see all project from the Project List block of side 

bar.


3.2 Features of Sidebar Menu

3.2.1 Project List
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Click project name will show project property and the nodes belonged to this project.
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From the Project Manager, Project Users can see the Integrity Checking from the Setting block 

of side bar.


3.2.2 Setting

3.2.2.1 Integrity Checking
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It will check the integrity of project hierarchy, point database and alarm database, then show 

checking result in Status/ Error Statement.
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From the Project Manager, Project Users can see the Backup from the Setting block of side bar.


3.2.2.2 Backup
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 To Backup your Project(s)


1. Select Backup hyperlink.


2. This integrity check need a few minutes.


3. Click Submit for backup job.
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4. You will have a second waiting period, while the actual backup takes place. This can take 

several minutes for a large project. Very large databases may require increasing the Script 

Time Out on the Project Node (Web Server) in order for the Integrity Check to run to 

completion.


5. A completion Message appears describing the full path to the backup, typically: 

C:\WebAccess\Node\backup


7. Click done to return to Project Manager Home page.


3.2.2.3 Restore
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From the Project Manager, Project Users can see the Restore from the Setting block of side bar.


 To Restore your Project(s)


1. Select Restore hyperlink.


2. This integrity check need a few minutes.


3. Click Submit for restore job.
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4. The Confirmation appears confirming restore completion. This can take several minutes for 

a large database.  Very large databases may require changing the script time out set  in 

Project Properties in order for the Integrity Check to run to completion.


5. Click done to return to Project Manager Home page.


The Users, Passwords & Security Section discusses Advantech WebAccess/SCADA user 

accounts in detail.


3.2.1.4 Admin/Project User
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In brief, Project Users and the admin account can access the Project Manager.  Project Users 

can not access the SCADA Nodes, unless a second account is created in Users in Project 

Properties.


The admin account is a special account that can not be erased or renamed.  The admin account 

can access all SCADA Nodes and the Project Manager. The admin account and Project User 

passwords can be changed in either from the Admin / Project User on the Project Home Page or 

in Users under Project Properties.


Admin / Project User Properties allows you to modify the Admin account and to create other 

user accounts with ADMIN like properties to access the Project Manager. Project Users are not 

assigned VIEW access to run time SCADA Nodes (unless you create another user account with 

the same name under SCADA node properties).


Users must "Login" using a Username and password. All users are assigned a User Type.  The 

User Types are administrator, project user, power user, general user and restricted user.  Only 

Admin and Project Users can access the Project Manager.


Please refer to the Users, Passwords & Security for a complete description of security.


User names are not case sensitive.    Passwords are case-sensitive.


Project User Types


Project Users and the admin account can access the Project Manager.  Project Users can not 

access the SCADA Nodes using VIEW or ViewDAQ, unless a second account is created 

in Users (on  Project Property Page) with the same user name and password.  Similarly, other 

Users can not access the Project Manager, unless a Project User account is created.


Can use Database Configuration Tool (Project Manager).


Can use Web DRAW to build and edit graphics.


Can View all Displays in system through Web Browser (including Action Log, Alarm Log, User 

Programs and Station Status Displays)


Access all tags using the Point List Dialog box.


Note - There is only one Administrator account in a project.  The default name is admin and can 

not be renamed


Can use Database Configuration Tool (Project Manager).


Can use Web DRAW to build and edit graphics.


Can NOT View displays in run-time.


Can View Reports, System Log, Analog Tag Log, Discrete Tag Log, Alarm Log and Action 

Log through Project Manager


Can Create, Modify and Download Schedules through Project Manager.


Administrator  


●

●

●

●

Project User


●

●

●

●

●

https://www.yuque.com/webaccess-scada/user/project-management/8.3_Graphic_Page_Access.htm#_Create_a_User
https://www.yuque.com/webaccess-scada/user/project-management/8.3_Graphic_Page_Access.htm#_Add_or_Update
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Note - only Users that are assigned as Project Users can use the Database Configuration Tool 

(Project Manager) or use web-browser based DRAW.


Note 2 - The Project User can also be assigned as either a power, general or restricted user to 

enable viewing graphics in run-time View.


A user with all the security features of Admin can be created by creating two accounts with the 

same name, a Project User and a Power User (with security Level 127 for all Areas, Local Tag, 

View Tag, etc.).


Create or Update Admin/Project User


1. Log in to Project Manager or if already connected.


2. If your login username is 'admin', from the Project Manager, Project Users can see 

the Admin / Project User Property from the Setting block of side bar.
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3. Admin/Project User appear.


4. Click the Insert button, the Create Admin/Project User dialog opens.


5. Enter User name and password to create a new users account.


6. Enter the password twice to verify correct entry.
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7. Submit.
8. Select Update to modify an existing account.


9. The update Admin/Project Users page appears.
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10. Make you changes and press submit.


Update Project User Property


1. Log in to Project Manager or if already connected.


2. If your login username isn't 'admin', from the Project Manager, Project Users can see the 

Admin / Project User Property from the Setting block of side bar.
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3. Updata Project User Imformation appears.
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You can create users with all the abilities of an admin by creating Project User account and 

a User Account with the same name. The user should be given Security level 127 (admin level) 

for all Areas, Local Tag, View Tag and Exit ViewDAQ.


From the Project Manager, Project Users can see the ODBC/MongoDB Log Data Source from 

the Setting block of side bar.


Note – change then user name renames the existing account (it does not create a copy).

3.2.2.5 ODBC/MongoDB Log Data Source


https://www.yuque.com/webaccess-scada/user/project-management/8.3_Graphic_Page_Access.htm#_Create_a_User
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Advantech WebAccess/SCADA users can configure flexible measuring point and events to store 

the database, and can let users choose to store data sheet to the month, shorten the query time 

when record data or generate reports, the user can also choose different data source to query.


In the past, WebAccess/SCADA only can store the historical data into one database through the 

same DSN, but from V8.3, you can create multiple DSNs and store the data into them 

simultaneously.    


Advantech WebAccess/SCADA can record real-time data to a database. A Microsoft Access 

database is supplied with Advantech WebAccess/SCADA (bwPdata.mdb) and includes:


 Analog Tag Log


 Discrete Tag Log


 Text Tag Log


 Analog Tag Log


 System Log


 Action Log


 Alarm Logs 


The Data for Scheduled reports are also stored in this database.


The Project Node records data to this database. Multiple Users can view this database using the 

Project Logs or Scheduled Reports accessible from the Project Manager, VIEW and ViewDAQ. 

Note than even though Access is a single-user database, multiple users can access the IIS web 

server making the Access database act like a multi-user database though IIS.


Users may want to relocate this database to another hard drive or use another database. 

Advantech WebAccess/SCADA supports the following Databases:


Microsoft Access


Microsoft SQL Server


Oracle


MySQL


MongoDB


The Log Data Source allows users to replace or relocate the Access Database (bwPdata.mdb) 

that is the default database used for recording Process Data. This is done by creating another 

DSN (Data Source Name) that points to the new database and entering that name in the Log 

Data Source page in the Project Manager.


User Patitioned Tables


Users can through the drop-down menu enabled or disable using the monthly data table is 

stored, the monthly data table has analog measuring point, analogy change records, digital 

record of measuring points, points record table text. The existence of a monthly data sheet can 

help speed up the query.  


System records, action records, alarm records, and event records are still stored with a single 

data table.


●

●

●

●

●

●

●

●

●

●

●

●
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Create an ODBC/MongoDB Log Data Source


1. Select ODBC Log Data Source hyperlink.


2. Log Data Source appear.


3. Click the Insert button, the Create New ODBC/MoggoDB Log Data Source dialog opens.
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User can select the type of database is ODBC or MongoDB.


Enter the Data Source ID, 1~255, it is unrepeatable.


Enter the Data Source Name, the DSN that points to the new database.


Enter the user name (Data Source Login Name) to log in to SQL Server using SQL 

Authentication.  See Install SQL Server 2005 for more information.


Enter the login users' password (Data Source Password)


Retype Data Source Password.  


Optionally enter a Description.


Press Submit.


●

●

●

●

●

●

●

●
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If the Database type is MongoDB, you need setting other information:


Enter the Database port, the default is 27017.


Enter user will be connection the name of the database.


Use TLS connection or not through the radio button. If choose yes, need upload TLS 

certificate file.


Enter the name of the database that stores the account password.


Other connection setting.


  


●

●

●

●

●
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Select new ODBC/MongoDB Log Data Source


1. Select ODBC Log Data Source hyperlink.


2. The ODBC Log Data Source page opens.


3. Click the Radio Button under Select for the DSN to use.


4. Select OK to confirm the change.


You do not need to download. The change is immediate.


The Express Function also provides users with a global mode for auto discovery via the internet. 

All express functions are implemented from the WebAccess Express on Project node properties 

and the display page of the project will be shown directly on the Web Client.


From the Project Manager, Project Users can see the WebAccess Express from the Setting 

block of side bar.


3.2.2.6 WebAccess Express
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WebAccess Express main page：The page will show the list of the last  discovered devices. 

If users don’t need to add devices to monitor, they can select the device and Go Online 

directly.


●
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Setting：Users can discover specific COM Ports and the SNMP IP range of the devices or 

platforms.


Click Discover after setting the COM Port and SNMP IP Address range to auto-scan the 

device that WebAccess Express supports in the same domain.


The page returns to the main page after discovering devices.


Select the monitoring device from Device list and click Submit to display the data.


●

●

●

●
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Online graphics page


From the Project Manager, Project Users can see the Dashboard SRP Frame from the Setting 

block of side bar if installed WISE-Paas Dashboard.


●

3.2.2.7 Dashboard SRP Frame
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1. Click the Insert button, the Create New Dashboard SRP Frame Mapping dialog opens.
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2. The name of  Dashboard SRP Frame Name needs to match Dashboard setting.


3. Submit.

Advantech WebAccess/SCADA will automatically archive the Data Log Trend Files and ODBC 

database records to another drive, network folder or other media (zip drive, tape drive, etc). 

 This prevents the number of files from growing too numerous and consuming disk space.


Advantech WebAccess/SCADA can also delete Data Log Files and records from the ODBC Logs 

(System, Analog, Discrete, Alarm and Action Logs) to prevent files from growing to large, 

slowing response of reports and consuming disk space.


Advantech WebAccess/SCADA can automatically generate Excel report of ODBC database 

records in the form of daily,weekly or monthly. 


From the Project Manager, Project Users can see the LogData Maintenance from the Setting 

block of side bar.


3.2.2.8 LogData Maintenance
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To enable the automatic archiving or deletion of older Trend and Log Data or generation of 

Excel report
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1. Check ARCHIVE only if you have a fast network hard drive with sufficient capacity. A Zip 

drive is probably inadequate except for the smallest application (less than 0 tags). If Archive 

is selected, but the Archive can not be completed due to an error (the drive is full or folder 

not available) the Data will not be deleted (if Delete Expired Log is selected).


a. Warning - Do not archive to the same drive or partition that Advantech 

WebAccess/SCADA is installed on. There is no benefit and it more than doubles the 

ODBC Databases and file sizes. The Archive media should be a second hard drive on the 

SCADA Node or Project Node, or a network drive. Zip drives are usually too small. Tape 

Drives are too slow. If want to Archive to tape, it is recommended to Archive to a  second 

drive or network drive, then manually archive to tape.


2. Check Delete Expired Log to prevent your disk space from being consumed. You can select 

to delete files and data records without archiving. DataLog Trend files are deleted as 

complete files (since a file is created for each daily, monthly and yearly for each tag). 

Individual Records are deleted from the database.


a. Note -Advantech WebAccess does not compact the BwPdata.mdb database used for 

Data         logging. The database file size should be monitored (and compacted) if it 

grows too large. 


3. Specify an Expiration Time for data.


4. Specify a Time of Day to perform the Archive and/or Deletion.


From the Project Manager, Project Users can see the Setup HTTPS Setting from the Setting 

block of side bar.


3.2.2.9 Setup HTTPS Service
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Choose Certificate


If HTTPS is enabled, certificate is required. Advantech WebAccess/SCADA provide 3  certifacte 

source options.


Built-in Certificate


Upload Certificate


Create Certificate


Built-in Certificate


1. Please select "Built-in Certificate"  if using this method.


2. And then click on "Save".


●

●

●
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Upload Certificate


1. Please select "Upload Certificate" if you are using your own certificate.


2. Upload certificate file and enter the password.


3. Enter domain name of the Domain List.
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Create Certificate


1. Enter the certificate name, passowrd, and domain.


2. Enter the years of validation.


3. Enter domain name of the Domain List.
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From the Project Manager, Project Users can see the MQTT Broker from the Setting block of 

side bar.


3.2.2.10 MQTT Broker
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Edit the MQTT connection information


User can edit default data through click the Enable button.


The MQTT broker username and password on the cloud connection setting must be 

the same as the MQTT broker setting the on the cloud WebAccess.


If WebAccess is installed in the public domain server,please set the public IP address as the 

default node IP.


●

●

●
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The System Log monitors Project Users' Actions in the Project Manager.


Record Type


Log In


Log Out


Start Node


Stop Node


Start View


Start Draw


Download database to Node


Download Graphics


3.2.3 Log

3.2.3.1 System Log


●

●

●

●

●

●

●

●
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Create or Delete SCADA Node


Create or Delete a Project


Log Data Maintenance modification


Create, Delete or update Comport


Create, Delete or update Device


Create, Delete or update Tag


Create, Delete or update other properties


Usage


Search


1. Select the filters for the records you would like to search.


●

●

●

●

●

●

●
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Starting Date  - is the Earliest Date the Query will search for records.


Ending Date  - is the Most Recent date the Query will search for records.


Project Name  -If you have multiple Projects, this will limit the project included.  (Note – 

there is usually only one project in most systems). Use ALL Projects to query records from 

all projects.


Node Name – is the SCADA Node the query is applied.


User Name – is the Project User. (Note - Only Project Users and admin can access the 

Project Manager, download, start/stop nodes.)


IP Address - IP Address of Node.


Other – is the Project Manager actions used to configure tags, reports, build graphics, etc.

Log In – Project User Logins to Project Manager. (Note - see System Action Log for 

user logins to SCADA Node using VIEW).


Log Out – User logs out of Project Manager


Start Node – Start SCADA Node


Stop Node – Stop SCADA Node


Start View – Use the Start VIEW from Project Manager, SCADA Node Property 

page (see System Action Log for user logins to SCADA Node using VIEW outside of 

Project Manager or ViewDAQ).


Start Draw – Start DRAW from Project Manager – SCADA Node Property Page.


Download database to SCADA Node


Download Graphics using Graph Only link in SCADA Node Property


Create or Delete SCADA Node


Create or Delete a Project


Log Data Maintenance modification records Project Users changes to frequency and 

type of scheduled archive and scheduled data log record deletion.


2. Press "Submit" to query.


Result


The search result will be in form of a table.


Date , Time , Project Name, Node Name , Action, User Name and IP can be ordered by 

decending sequence.

●

●

●

●

●

●

●

○

○

○

○

○

○

○

○

○

○

○

https://www.yuque.com/webaccess-scada/user/project-management/edit
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This shows a centralized Action Log for all SCADA Nodes in the project with Action Log to 

ODBC enabled. This is very similar to the Action Log in VIEW and ViewDAQ, but applied to all 

SCADA Nodes and Projects. The Action Log monitors Power User, General User, and Restricted 

User actions on the SCADA node. Action Log To ODBC or MongoDB must be enabled in the 

SCADA node properties.


The Action Log shows:


User changes to Tags (e.g. setpoint changes, auto/manual and equipment changes).


User Log-ins to SCADA Node using VIEW and ViewDAQ


From the Project Manager, Project Users can see the Action Log from the Log block of side bar.


3.2.3.2 Action Log


●

●

https://www.yuque.com/webaccess-scada/user/project-management/edit
https://www.yuque.com/webaccess-scada/user/project-management/edit
https://www.yuque.com/webaccess-scada/user/project-management/8.2.3_Power_User.htm
https://www.yuque.com/webaccess-scada/user/project-management/edit
https://www.yuque.com/webaccess-scada/user/project-management/edit
https://www.yuque.com/webaccess-scada/user/project-management/edit
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Power Users can also see this Action Log from VIEW using the Tools menu:Right Click -> Tools 

-> System Action Log.
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All Users can also see this Action Log from ViewDAQ using the menu bar:Tools -> System 

Action Log.


Search
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The Action Log can be sorted and filtered by Time, Date, tag, computer, node and IP addresses.
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An HTML report is printed.


The system display used by VIEW and ViewDAQ is bwActlog.uti.


The data is contained on the Project Node at drive:\WebAccess\Node\bwPDATA.mdb


The database table is  BwActionTable: User action log table.


ProjNodeId : Unique ID for a SCADA node.


LogDate : Date of  the record was recorded.


LogTime : Time of the record was recorded.


Priority : Not Used.


TagName : Tag name, if it is tag related record.


Description : Tag Description


Action : Description of the User Action


UserName : The user who made the action


NodeName : The node that this action happened.


NodeIP : The IP address of the node where the action happened.


This shows a centralized Alarm Log for all SCADA Nodes and all projects with Alarm Log to 

ODBC enabled.


From the Project Manager, Project Users can see the Alarm Log from the side bar.


●

●

●

●

●

●

●

●

●

●

3.2.3.3 Alarm Log


https://www.yuque.com/webaccess-scada/user/project-management/edit
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Power Users can also see this Action Log from VIEW using the Tools menu:Right Click -> Tools 

-> System Alarm Log.
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All Users can also see this Action Log from ViewDAQ using the menu bar:Tools -> System 

Alarm Log.


Search


These can be sorted and filtered by Date, Project Name, Node Name, Tag Name, User Name, 

Alarm Group and Priority.
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An HTML report is printed.

The system display used in VIEW is bwalmlog.uti


The data is contained on the Project Node at drive:\WebAccess\Node\bwPDATA.mdb


The database table is BwAlarmTable: Alarm log table


ProjNodeId : Unique ID for a SCADA node.


LogDate : Date of  the record was recorded.


LogTime : Time of the record was recorded.


Priority : Alarm priority.


TagName : Tag name.


Description : Tag Description


Action : Alarm information


UserName : User involved in the alarm action.


NodeName : SCADA Node


NodeIP : Not used.


This shows a centralized database for all Analog Tags for all SCADA Nodes in the project 

with Data Log to ODBC enabled.


The individual tags must have both Data Log DB enabled and Log to ODBC Frequency must be 

greater than zero.


These can be sorted and filtered by Time, Date, and node addresses. An HTML report is 

displayed which can be copied and pasted into EXCEL, WORD and other office applications 

preserving the cell, column and other formatting.


●

●

●

●

●

●

●

●

●

●

3.2.3.4 Analog Log


https://www.yuque.com/webaccess-scada/user/project-management/edit
https://www.yuque.com/webaccess-scada/user/project-management/4.2.16_Data_Log_DB.htm
https://www.yuque.com/webaccess-scada/user/project-management/4.2.29_Log_to_ODBC_Frequency.htm
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From the Project Manager, Project Users can see the Analog Log from the side bar.


Power Users can also see this Log from VIEW using the Tools menu:Right Click -> Tools -> 

Analog Tag Log.
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All Users can also see this Log from ViewDAQ using the menu bar:Tools -> Analog Tag Log.


Search


The Analog Tag Log contains values of all tags on all Project and All SCADA nodes that have log 

to ODBC enabled for the SCADA node and the tags.
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It can be sorted and filtered by Project, SCADA Node, Date, and Tag name.
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An HTML report is displayed .

The reporting period is always one minute.


The number of samples in the reporting period is fixed at one minute.  This is the same as the 

record interval in the bwAnalogTable in the ODBC database (default is bwPDATA.mdb).  The 

number of samples used to make up a record (a one-minute value) is determined by the Tag's 

configuration of Log to ODBC Frequency.  The Maximum, Minimum and Average values are 

based on how many samples at the Log to ODBC Frequency fit into one minute.  If log to ODBC 

is 1 seconds, then there are 60 samples. If log to ODBC is one minute, then there is one sample. 

 If communications fails or is very slow, there maybe fewer samples (i.e. if communications can 

not keep up with the Log to ODBC Frequency, then there may be fewer than the requested 

samples).


The default number of records per page for log displays is to 600.


The display used is bwanalog.uti.


BwAnalogTable : Data log for Analog tag


a. ProjNodeId : Unique ID for a SCADA node.


b. TagName : Tag Name.


c. LogDate : Date of  the record was recorded.


d. LogTime : Time of the record was recorded.


e. MaxValue: Maximum value of the recording period.
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f. AvgValue: Average value of the recording period.


g. MinValue: Minimum value of the recording period.


h. LastValue: The Maximum value of the recording period.


i. Alarm: If the tag is in alarm during the recording period.


-2147483648 (Decimal) or  0x80000000 (HEX) means there is  no data during the minute 

of collection.  Otherwise, the value of this field is a LOGICAL OR of all the Alarms that 

occurred during the interval.


Alarm Code    Alarm Code   Description


      Decimal           Hex             


-2147483648   0x80000000     no data during the minute of collection.


                              2   0x02                Acknowledged Alarm


                              4   0x04                High High Alarm


                              8   0x08                High Alarm


                             16  0x10                Low Alarm


                             32  0x20                Low Low Alarm


                             64  0x40                Rate of change Alarm


                            128 0x80                High Deviation Alarm


                            256 0x100              Low Deviation Alarm


This shows a centralized database for all Analog Tags, with Analog Change Log enabled, for all 

SCADA Nodes and all Projects.


The individual tags must have both Analog Change Log enabled and the values must exceed the 

Analog Change Log Dead Band to be logged.


From the Project Manager, Project Users call the Analog Change Log from the side bar.


3.2.3.5 Analog Change Log
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Power Users can also call this Log from VIEW using the Tools menu:Right Click -> Tools -> 

Analog Change Log.




88

All Users can call this Log from ViewDAQ using the menu bar:Tools -> Analog Change Log.


Search
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The data can be sorted and filtered by Tagname, Date, Project, and SCADA Node.  
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An HTML report is displayed .

The display used is bwchglog.uti.


BwAnaChglog : Data log for Analog tag


a. ProjNodeId : Unique ID for a SCADA node.


b. TagName : Tag Name.


c. LogDate : Date of  the record was recorded.


d. LogTime : Time of the record was recorded.


e. LogMillisecond: Millisecond of the record.


f. LogValue: Value of the recording period.


g. MinValue: Minimum value of the recording period.


h. Alarm: If the tag is in alarm during the recording period.


-2147483648 (Decimal) or  0x80000000 (HEX) means there is  no data during the minute 

of collection.  Otherwise, the value of this field is a LOGICAL OR of all the Alarms that 

occurred during the interval.


Alarm Code    Alarm Code   Description


Decimal           Hex             


-2147483648   0x80000000   no data during the minute of collection.


                2   0x02            Acknowledged Alarm


                4   0x04            High High Alarm


                8   0x08            High Alarm


               16  0x10             Low Alarm


               32  0x20             Low Low Alarm


               64  0x40             Rate of change Alarm
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              128  0x80            High Deviation Alarm


              256  0x100           Low Deviation Alarm


This shows a centralized database for all Discrete Tags for all SCADA Nodes in the project 

with Data Log to ODBC enabled.


The individual Tags must have both Log Data enabled and Log to ODBC enabled.


From the Project Manager, Project Users can see the Discrete Log from the side bar.


Power Users can also see this Log from VIEW using the Tools menu:Right Click -> Tools -> 

Discrete Tag Log.


3.2.3.6 Discrete Log
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All Users can also see this Log from ViewDAQ using the menu bar:Tools -> Discrete Tag Log.


Search
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The data can be sorted and filtered by Time, Date, and node addresses.
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An HTML report is printed.

The display used in VIEW is bwdislog.uti.


Data is recorded on a change of state basis. If the Discrete tag does not change, no data is 

recorded.  The value of the state may range from 0 to 7 (a 3 bit integer) depending on how 

the Discrete Tag length is configured. A typical Digital tag will have two states (0 and 1). To 

evaluate the meaning of the state number, you must reference how the tag is configured for 

each state descriptor.


Length                   State Descriptors Used


                   1-BIT            STATE 0 and STATE 1


                   2-BITS          STATE 0, 1, 2, and STATE 3


3-BITS          STATE 0 thru STATE 7


 


For related information, refer to Data Log Trend Display in the System & Template 

Displays section.


BwDiscreteTable : Data log for Discrete tags


a. ProjNodeId : Unique ID for a SCADA node.


b. TagName : Tag Name.


c. LogDate : Date of  the record was recorded.


d. LogTime : Time of the record was recorded.


e. LogMilliSecond : The millisecond of the time of the record was recorded


https://www.yuque.com/webaccess-scada/user/project-management/4.3.11_Length.htm
https://www.yuque.com/webaccess-scada/user/project-management/4.3.21_State_Descriptors_0_-_7.htm
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f. LogValue : The value was recorded.


g. Alarm: If the tag is in alarm during the recording period.


-2147483648 (Decimal) or  0x80000000 (HEX) means there is  no data during the minute 

of collection.  Otherwise, the value of this field is a LOGICAL OR of all the Alarms that 

occurred during the interval.


Alarm Code    Alarm Code   Description


        Decimal           Hex             


-2147483648   0x80000000    no data during the minute of collection.


                2   0x02             Acknowledged Alarm


             512  0x200             Discrete Alarm


This shows a centralized database for all Text Tags for all SCADA Nodes in the project with Data 

Log to ODBC enabled.


The individual Tags must have both Log Data enabled and Log to ODBC enabled.


From the Project Manager, Project Users can see the Text Tag  Log from the side bar.


3.2.3.7 Text Log
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Power Users can also see this Log from VIEW using the Tools menu:Right Click -> Tools -> 

Text Tag Log.
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All Users can also see this Log from ViewDAQ using the menu bar:Tools -> Analog Tag Log.


Search


The data can be sorted and filtered by Time, Date, and node addresses.
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An HTML report is printed.

The display used is bwtxtlog.uti.


BwTextTable : Data log for Analog tag


a. ProjNodeId : Unique ID for a SCADA node.


b. TagName : Tag Name.


c. LogDate : Date of  the record was recorded.


d. LogTime : Time of the record was recorded.


e. TextData : The data recorded.


Similar in concept to a Sequence of Events Recorder, The Event log will log user-defined 

number of sample before the event and after the event. The data is logged to an ODBC database 

on the Project Node. 


Project Users can view an Event Log from the Side bar.

3.2.3.8 Event Logs
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All Users can also see this Action Log from ViewDAQ using the menu bar:Tools -> Event Log.
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Search


Up to 22 Tags can be logged to a single Event Log based on the status of a single tag (the Event 

Tag).  Resolution can be from 1 millisecond to 1 hour.  The Actual resolution depends on you 

computer hardware, network connections and communications to field device (e.g. PLC). 

 Multiple Event Logs can be configured.


Event Types that will trigger logging include:


Event Tag >= Reference Value


Event Tag <= Reference Value


Event Tag == Reference Value


Event Tag >= Reference Tag


Event Tag <= Reference Tag


Event Tag == Reference Tag (Supports text tag)


Record Every Sample Interval


●

●

●

●

●

●

●



102



103

An HTML report is printed.

Device Driver is setting Parameter of Device Type and Block.


Expand Device Driver block in Side bar.


3.2.4 Device Drivers
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This section assumes you have started Internet Explorer 6.0 or later Web Browser and connected 

to your Project Node.


 Pick on your Device Type (for example, pick Modicon if you are to create a parameter for 

your Modbus Driver).


The Parameters Set for the Device Type (driver) opens.


3.2.4.1 Add Parameter


●

●
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 Click insert button. The Create Parameter dialog opens.
●



106
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Select a Parameter Type from the Pull Down List.


This is the first step in creating a Parameter.  The important thing is to get the Data type 

correct, you cannot change from Analog to Discrete to Text.  All other properties can be 

changed.


Analog parameter  is at least 4 bits of data and greater (up 16 bits or 32 bits depending on 

the driver) that are interpreted as numbers. Floating-point numbers and any value over 7 must 

be created as an Analog Type.


A Discrete parameter is 1 to 3 bits of data and is interpreted as "digital" (0 or 1) or as a 

"discrete" integer between 0 and 7.


Text parameter is data read as ASCII strings. The size is dependent on the driver, but always 

less than 70 characters.

 If you select a Discrete or Text type parameter, the Page will change to the appropriate 

page for Discrete of Text type parameters.


Refer to the Following Sections for Analog, Discrete and Text Parameter Properties for a 

description of each entry on the Page.


Analog Parameter Properties


Discrete Parameter Properties


Text Parameter Properties


Press Submit when you are finished entering Data.


You can edit parameters using the Parameter Properties.


Pick the Device (for example, pick Modicon)


The Parameter set for the selected device appears.


●

●

●

○

○

○

●

●

3.2.4.2 Edit Parameter Set


●

●
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Parameters are organized by type, and then listed alphabetically.  Digital or Text type 

parameters are listed separately from Analog parameters (and listed separately from each 

other).  If you created a parameter and don't see it listed alphabetically with your analog 

parameters, try scrolling down to the Digital and Text parameters for your parameter type.


 Click update button.


The Parameter Properties dialog opens.(for example, pick Analog Parameter Properties)


Analog Parameter Properties


Discrete Parameter Properties


Text Parameter Properties


●

●

○

○

○
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Press Submit when you are finished entering Data.


Modifications to the Parameter Properties will only affect New Tags and Blocks.  To modify the 

Parameters in an existing Tag or Block, you will have to update those tags and Blocks 

individually.


●

3.2.4.3 Add a Block Type
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This section assumes you have already created the PARAMETERS you plan to group into a Block 

type. Please refer to Add Parameter section for information about building Parameters to use in 

your Block Type Template.


 Pick on your Device Type (for example, pick Modicon if you are to create a parameter for 

your Modbus Driver).


The Parameters Set for the Device Type (driver) opens.


Select Block List, and click insert button.


The Create New Block dialog appears.


●

●

●

●
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Enter a Block Name for Your Block Type. Pick a name that is descriptive of its function. This 

name will also have to match the Block Detail Display if you are planning to use the Block 

Detail Display in your Project.


The Name will become the Block Type referenced when you create Block Tag. Typical Block 

Types include PID, CASCADE, VAV, AHU and PUMP. You can use the tag field BTYPE to read the 

BTYPE of an existing Block during the run-time VIEW.


It is possible to use the same BTYPE in to different devices.  This may cause difficulties with 

the GOTO Block Detail Display. If a Block Detail Display is named after this block, it can be 

called used the GOTO BDETAIL command in pushbutton keymacros, the GOTO Dialog Box and 

scripts


Check the Parameters you want group into this Block Type.


Select Submit when finished.


●

●

●
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This section assumes you have already created the PARAMETERS you plan to group into a Block 

type. Please refer to Add Parameter section for  information about building Parameters to use in 

your Block Type Template.


Pick the Device (for example, pick Modicon)


The Parameter set for the selected device appears. The Blocks are listed at the bottom of 

the page (you may have to use the scroll bar to see them).


Select Block List  and click edit button.


The Update New Block dialog appears.


3.2.4.4 Edit Block Type


●

●

●

●



113

You can add or delete Parameters from your Block Type by checking the box next to each 

parameter name.


Changing the name will rename the Block Type.  It will not create a new block. 


Select Submit when finished.


Changes to Block Type will only affect New Blocks that you create.  You must re-create existing 

Blocks using this new Block Type in order to add parameters to an existing Block Tags.


If you rename your Block Type, you must rename the  Block Detail Displays you have created. 

Any previous Block Tags created with the old Block Type Name will still have the reference to 

the old Block Type name, which may affect your Block Detail Displays. 


●

●

●
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You can see the project organizational chart after you click the project name on project list. If 

this is the first time you configure this project, you will see the project name you clicked on the 

left.


Project Property shows project details such as Project Node IP Address, TCP Port..., etc.


You can search any tags or blocks on the tag search box.


4. Project Configuration (Project Node)


Project Organizational Chart
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The complete project organizational chart generated when you finish related configuration. The 

first layer is Project 
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layer. The functions including Insert, Edit and Viewers on the upper banner.

The second layer is Node layer. Node bar show on the upper banner. You can 

Insert Comport/Point here.


The third layer is Comport/Point layer. You can insert the device under the comport or point 

you selected.




117

The fourth layer is Device layer. You can insert the tag and block under the device you selected.
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The fifth layer is 

Tag/Block layer. You can enter the Tag List/Block List page when you click Tag/Block.

1. Select your Project.

2. Click Insert classification on top banner, then select New Node.


Add SCADA Node
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3. You will see the Create New SCADA Node dialog.


4. Enter a Node Name for this SCADA node. This is the name that users will see in the caption 
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bar of VIEW and use to select this node from a list of nodes if your have multiple SCADA 

nodes.


Note - The Project Name with the SCADA node name appended to it will appear in ViewDAQ and 

DrawDAQ menu lists (ProjectName_NodeName).


5. Optionally, enter a Description.


6. Enter the IP address of the SCADA node.  The Project Node IP Address appears by default.   

Be sure to enter the IP Address of the SCADA node. You can also use a URL or Computer 

Name. 


7. If connecting through a Firewall, enter the Primary Port Number of a TCP port assigned by 

your system administrator. If not using a Firewall, accept the default: 0.  Note that 0 means 

the default primary port number (4592).


8. If connecting through a Firewall, enter the Secondary Port Number of a TCP port assigned 

by your system administrator. If not using a Firewall, accept the default: 0.  Note that 0 

means the default secondary port number (14592).


9. Advantech WebAccess/SCADA uses the HTTP port plus requires 2 additional TCP ports; do 

not use the same port number for both primary and secondary ports if you are connecting 

through a firewall.


10. Firewalls - Three (3) TCP ports are required. Typically port 80 is already open, this is the 

port for HTTP (web and ASP pages). Advantech WebAccess/SCADA needs two additional 

ports:


a. Primary port (default 4592) for file transfer


b. Secondary Port (default 14592) for real-time data


11. Port Mapping and Network Address Translation (NAT).  This is were Private IP addresses of 

a corporate intranet use a single public IP address. The same ports described for firewall 

must be mapped in NAT also. For more information, see TCP Ports & Firewalls and Routers & 

NAT in the Security Section of this Manual or the Configuration Manual.


12. It is recommended to accept the default Node Time Out. 0 means the default value is used 

(15 seconds).  SCADA Node Time out can range from 1 to 60 seconds. This is the time for 

normal communications between the SCADA Node and a VIEW Client, the Project Node and 

the ASP Server. If you have a very slow network connection between the Project and SCADA 

nodes, you may have to increase this value.


13. Enter the Remote Access Code for the SCADA node entered during software installation of 

the SCADA node software.  The Project Nodes Remote Access Code appears by default. The 

SCADA Node and Project Node do not necessarily have the same Access Code.  This Remote 

Access Code is to prevent unauthorized use of your SCADA node. This code was established 

when the SCADA Node software was installed.


14. Leave the information about Alarm Log, Printers, Action Log, Alarm Beep, email and other 

fields blank for now.
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Choose Yes on Redundant SCADA Node if necessary. Enter its IP address, node name, firewall 

ports and remote access code.


16. If you want more setting, the left navbar has other classifications: Email(SMTP), 

Email(POP3), Alarm And Action, Data log, System, View and Super SCADA and SCADA.
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18. Enter Email(SMTP) information in this block.




123

19. Choose Yes on Reply Alarm Email To Ack, then you can enter the Email(POP3) information 

in this block.
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20. Choose Yes on Global Script Via Email, if you need. The  Global Script Security Code 

and Retype Global Script Security Code is required when Global Script Via Email option 

status is Yes.
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21. Enter  Alarm information in this block.
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22. Enter Action Log information in this block.
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23. Enter Data Log information in this block.
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23. Enter System information in this block.
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24. Enter ViewDAQ information in this block.
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25. Enter Super SCADA information in this block.
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26. You will see the node under the project. 
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Imports a SCADA node from another Project. All Tags, Blocks, Graphics, Scripts, Keymacro 

Files, Recipes, Schedules, etc. Everything. Import SCADA Node allows you to both Merge 

Projects and Split projects up.


1. Select your Project.

2. Click Insert classification on top banner, then select Import Node.


3. Enter IP address or URL of remote Project Node.


4. Enter Project Primary TCP Port .


5. Enter Remote Access Code.





6. A new page appears listing SCADA Nodes in the remote project.


Import SCADA Node


Note - A Remote Access Code prevents others from copying your SCADA node
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7. Optionally, check Import box to import all SCADA nodes.


8. Check the box for each SCADA node to be imported (if you are not importing all SCADA 

nodes.


9. Optionally Rename the new SCADA Nodes to be imported.


10. Submit.
11. A dialog will show progress of the import.


12.  A success report should appear.
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1. Select your Project.

2. Click Insert classification on top banner, then select Upload Node.


Upload SCADA Node
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3. Enter Project Node IP Address, Project Primary TCP Port and other information.


4. Submit.

1. Select your Project.

2. Click Edit on top banner.


Edit SCADA Node
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3. Modify the information you need.


4. Submit.
 


1. Select your Project, then click Viewers on top banner.


2. Click Add and select Add User.


Add Viewers
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3. Select User Type.


Power User


a. Access all user-built displays through Web Browser.


b. All System Displays including Action Log, Alarm Log, User Programs and Station Status 

Displays through Web Browser.


c. Access all tags through Point List through Web Browser.


d. Can View Scheduled Reports and ODBC Logs from the Tools Menu in VIEW.


General User


a. Access all user-built displays through Web Browser.


b. Cannot view System Displays: Action Log, Alarm Log, User Programs and Station Status 

Displays through Web Browser.


c. Access all tags through Point List through Web Browser.


Restricted User


a. Must be assigned a default graphic on each SCADA in order to access any graphic 

displays on that SCADA Node through Web Browser. If no default graphic assigned, 

users cannot access that SCADA Node.


b. Access only Specified Displays through a web browser. A maximum of 100 displays are 

available to a restricted user through a web-browser connection. (20 plus the default 

graphic).


c. Access Point Detail and Block Detail Display of any tag on those graphics.


●

●

●
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d. Cannot view Alarm Summary, Overviews, Faceplates Groups, Trends or Alarm Groups 

through Web Browser.


e. Cannot view System Displays (Action Log, Alarm Log, User Programs and Station 

Status Displays) through Web Browser.


f. Cannot view Scheduled Reports, Scheduler, Logs or other functions from the Tools 

Menu through a Web Browser.


g. Can view only tags appearing on assigned graphic displays in the Point List.


h. Acknowledge Alarms on assigned Displays with ACK enabled under Graphic Page Access 

(User Properties) by an engineer or technician using Project Manager.


i. Change Values on assigned Displays with Change enabled under Graphic Page Access 

(User Properties) by an engineer or technician using Project Manager


j. Display access restrictions apply only to Web Browser based clients. Restricted User 

can view all displays and can acknowledge all alarms in ViewDAQ (local SCADA node).


k.  Restricted user account can be assigned different Display access on each SCADA node. 

 If the user is to access multiple SCADA nodes in your project, the user account must be 

assigned at least one display on each SCADA node. Having access to one SCADA node 

does not guarantee access to other SCADA nodes in the system.


4. Enter the information in Basic Information block.


5. The Password can be up to 8 characters and is case sensitive. There is no way to view the 

existing password. If you forgot it, you have to set a new password.


6. Enter the information in Security Area & Level block.
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7. Area corresponds to the Security Area the tags are assigned a user may change. To change 

the value of a Tag, users must be assigned a Security Level greater or equal to the Level 

assign to the Tag in the same Area the Tag is assigned.  A user may have a different Level 

for each Area of the project that the user is to access. Security Level can be from 0 to 127. 

(127 = admin) How many Areas you divide your plant by  your design. Many projects start 

with only one Area (Area 0).  Area 0 is the default for tags. You can leave unused Areas 

unchanged and fill in Level only for Areas that apply.


8. You can search current area tag in Tag List box.
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9. Select Security Level in every area.


10. Enter the information in View Security block.


11. Select a value of 127 in ViewDAQ if the user is to be able to modify and Save Display Groups 

in ViewDAQ. A number less than 127 defines the Exit Password Level this user has when 

trying to close ViewDAQ windows on the SCADA Node in order to exit ViewDAQ and stop the 

SCADA Node kernel locally.


12. Enter the information in Node Access block.




142

13. A user must be assigned to at least one node in the system. If the user is not assigned to a 

node, he/she will not be able to login to that node using VIEW or ViewDAQ.


14. Enter the information in Graphic Page Access block.


15. Power and General Users can be assigned a default Graphic that will appear when they log-

in. Otherwise, the Main.bgr graphic will appear. Power Users can View all displays including 

the System Displays (Action Log, Alarm Log, Station Status and Global Script Displays). 

General users can view all user built displays, trends, alarm summary and alarm group 

displays.


16. Drag the file from Existing List to center field.
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17. Enter the information in Dashboard Page Access block.


18. Drag the file from Existing List to center field.


1. Choose Add and select Excel In.


Import Viewer User
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2. Optionally modify the path and file name of the EXCEL Worksheet. 





3. Select No if you only want to insert new tags without overwriting existing tags.


4. Submit.

1. User List shows some user information like User Type, User Name and description. 


Note - this must be located on the Project Node.

User List
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2. The count of different user type shows on upper banner.  


3. You can sort by  User Type, User Name or Description.


4. Edit user when choose one user.


5. Delete users after you choose them.
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1. choose Export and select Download to SCADA.


2. Select target node.


Download to SCADA 
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3. Waiting for downloading.


1. Choose Add and select Export to Excel.


2. Enter the path and file name of the EXCEL Worksheet.


Export to Excel 
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3. Submit.

The Data Transfer function is for transfering data from one PLC or automation device to 

another. This is especially useful in single-master protocols or to exchange data between 

devices that have different communication protocols and are unable to communicate with each 

other directly.


The Data Transfer function allows you to designate pairs of tags in the Advantech 

WebAccess/SCADA to "transfer" data from the source to the target tag.  With Data Transfer 

feature configured, the Advantech WebAccess/SCADA SCADA node "reads" data from the 

source tag, then "writes" this data to the Target tag. The Data Transfer function saves the user 

the effort to write scripts to do the same thing.


Each tag pair consists of a source tag and a target tag such that the value of the source tag is 

automatically transferred to the target tag. The values of the two tags are compared against a 

deadband.  If the difference in values exceeds the dead band, the target tag is updated.  This 

minimizes traffic on the network. The frequency of checking is set from 500 milliseconds to 

60,000 milliseconds (½ second to 1 hour) for each tag pair.


With the Data Transfer, both points must reside on the same SCADA node.  


5. Node Configuration (SCADA Node)

5.1 Data Transfer
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1. Select your Project and the SCADA Node.


2. Click Tag classification on node bar, then select Data Transfer.


3. You will see the Data Transfer List.


4. Click Insert.


5. The Create Data Transfer Point page appears.


5.1.1 Configure Data Transfer
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6. Click once on the Source Tag field, then use the pull down Tag List to select a 

tag. Alternatively, you can type the tag name or copy and paste in a tag name.


7. Click once on the Target Tag field, then use the pull down Tag List to select a 

tag. Alternatively, you can type the tag name or copy and paste in a tag name. This tag will 

receive the value from the source tag.


8. Input the Check Time field. This is the frequency of checking the two tags in milliseconds 

(500 to 60,000 milliseconds or ½ second to 1 hour).


9. Input the Dead Band (%) field. This is the difference in value (in percent of full scale) 

between the two tags that will result in a data transfer from the source to the target.  A large 

dead band will minimize communications traffic.  A smaller dead band will increase 

communications and accuracy.


10. Submit when you are finished entering data.


11. You can use Edit or Delete on the Data Transfer List.


1. Select your Project and the SCADA Node.


2. Click Tag classification on node bar, then select Import External Data.


5.2 Import External Data

5.2.1 Entry
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3. You will see the Import External Data List.


5.2.2 Import ADAM5550 memory variables
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5.2.3 Import ADAM5510KW IO and memory variables




153

5.2.4 Import BAS2000 IO
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5.2.5 Import BAS3000 memory variables
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5.2.6 Import Lonworks Network Variables


5.2.7 Import APAX-5000/6000 memory variables
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5.2.8 Import ADAM-3600 Tags 
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1. Select your Project and the SCADA Node.


5.2.9 Import AdvPAC Tags


5.3 Real Time Trend

5.3.1 Configure Real Time Trend
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2. Click Trend classification on node bar, then select Real Time Trend.


3. You will see the Real Time Trend List.


4. Select Insert.

5. The Real Time Trend configuration page appears.
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6. Enter a Unique Group Number (between 1 and 1000). This is how the Group will be ordered in 

the Real Time Trend Dialog Box in VIEW and identified to Operators and Users.


7. Enter a Description for the group.  This will appear in the Real Time Trend Group List Dialog 

Box seen by users and operators in VIEW.


8. Enter a Sample Rate.  This is the frequency of updating the Trend Display with new 

Data.  Real Time Trends are fixed at 240 samples.  Sample Rate for Real Time Trends range 

from 1 to 180 seconds.


If 1 second interval and 240 samples = 1 x 240 = 240 seconds (4 minutes)


If 180 second interval and 240 samples = 180 x 240 = 43200 seconds


9. Select the field next to Tag Name 1.


10. Open the Pull down list by clicking on Tag List.  This shows the names of all Analog Tags and 

Discrete Tags.


11. Scroll down the Tag List. Click the Tag Name desired. The Tag Nameshould appear on the 

Tag Name 1 field.


12. Repeat for Tag Name 2 to 12.


13. You can Type Tag names and Blocks (BLOCK: PARAMETERs ).   You can also copy and paste 

Tag Names and Block Names from the Left Frame of your browser.


14. The Display High and Display Low to "zoom in" or "zoom out" of trend data. By default, 

Advantech WebAccess/SCADA uses the High Span and Low Span of the Tag. Data Log 

Trend Displays have configurable Display High and Display Low values for the y-axis (and x-

axis in X-Y Plots).  Trend displays will “remember” changes made to Display High and Low 

from VIEW and ViewDAQ. The Display High and Low are assigned to the Trend Group, 

allowing the same tag to have different sets of Display High and Low when assigned to 

multiple display groups.


15. Submit when you are finished.
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16.  You can Edit or Delete the objects on the  Real Time Trend List.


1. Select your Project and the SCADA Node.


2. Click Trend classification on node bar, then select Data Log Trend.


3. You will see the Data Log Trend List.


4. Select Insert.


5.4 Data Log Trend Server

5.4.1 Configure Data Log Trend
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5. The Data Log Trend configuration page appears.


6. Enter a Unique Group Number (between 1 and 1000). This is how the Group will be ordered in 

the Data Log Trend Group Dialog Box in VIEW and identified by Operators and Users.


7. Enter a Description for the group.  This will appear in the Data Log Trend Group List Dialog 

Box seen by users and operators in VIEW.


8. Select the pull-down list next to Time Span.  The default value is 6 minutes. This will 

determine the default time span and sample interval when this display first opens (the user 

can modify this on the fly). Data Log Trend supports the following time spans for viewing 

data: 6 minutes, 12 minutes, 30 minutes, 1 hour, 2 hours, 4 hours, 6 hours, 12 hours, 18 

hours, 24 hours, 2 days, 4 days, 1 week, 1/2 months, 1 month, 2 months, 3 months, 4 months, 

6 months, 1 year, 2 years, 3 years, 4 years, and 5 years. This feature allows the viewing of 

data at a sample frequency different than the recording frequency.  The intent is to allow 

users to adjust the time span across the screen. This does not affect the actual data 

recording rate. 


6 min is 1 second sample interval.


12 min is 2 second samples


30 min is 5 second samples


1 hour is 10 second samples  


4 hour is 40 second samples


6 hour is 1 minute samples

12 hour is 2 minute samples


1 day is 4 minute samples


2 day is 8 minute samples


1 week is 28 minute samples


15 days is 1 hour samples


○

○

○

○

○

○

○

○

○

○

○
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1 month is 2 hour samples


3 months is 6 hour samples


1 Year is daily samples


9. Select the field next to Tag Name 1.


10. Open the Pull down list by clicking on Tag List.  This shows the names of all Analog Tags 

with Log Data and Discrete Tags with Log Data set to yes.


11. Scroll down the Tag List. Click the Tag Name desired. The Tag Name should appear on the 

Tag Name 1 field.


12. Repeat from Tag Name 2 to 12.


13. If you did not enabled Data Log for a tag, you can enable data Log later and enter the tag 

name now. You can Type Tag names and Blocks (BLOCK: PARAMETERs). You can 

also copy and paste Tag Names and Block Names from the Left Frame of your browser.


14. Select the opening Plot Type that will appear for each tag.  Users can change this from VIEW 

in combination with the Time Period Chosen (Seconds, Minutes Hours, and Days).


LAST shows the last recorded value of the Tag during the time period.


Average shows the average value.


Minimum will show the smallest value.


Maximum will show the largest value.


If seconds are the time period chosen by the user, the Last value is always shown.  


Seconds is the default period chosen. You entry here will affect the Minutes, Hours and Day 

time periods.


15. The Display High and Display Low to "zoom in" or "zoom out" of trend data. By default, 

Advantech WebAccess/SCADA uses the High Span and Low Span of the Tag. Data Log 

Trend Displays have configurable Display High and Display Low values for the y-axis (and x-

axis in X-Y Plots). Trend displays will “remember” changes made to Display High and Low 

from VIEW and ViewDAQ. The Display High and Low are assigned to the Trend Group, 

allowing the same tag to have different sets of Display High and Low when assigned to 

multiple display groups.


16. Submit when you are finished.


17. There are two ways to download these changes to the SCADA Node:


a. Download and Restart the SCADA node from the SCADA Node properties page.  If you 

have never downloaded the SCADA node before, then this is required. This will 

temporarily stop the SCADA node (if it is running).


b. Use the Export on the Data Log Trend Display Group List Page. This will download 

changes to the Data Log Trends without stopping the SCADA node.


At least one Data Log Trend Display group must be configured to view Data Log Trends. 

The New Tag button can be used to add tags (temporarily) to any Data Log Trend Display.  If 

your users will regularly view the same tags in a trend, it is probably best to configure multiple 

Data Log trend groups for their convenience.


○

○

○

○

○

○

○
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 You have already created the BLOCKS and TAGS you plan to add to your Alarm Group Displays. 

 You can type in the Tag Names and Block Names of tags and blocks you plan to build. You can 

also select Blocks and Tags from the Pull Down List.


1. Select your Project and the SCADA Node.


2. Click Alarm classification on node bar, then select Alarm Group.


3. You will see the Alarm Group List.


5.5 Alarm Group


5.5.1 Configure alarm group
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4. Click Insert.


5. The Create Alarm Group page appears.


6.  Enter a Unique Group Number (between 1 and 9999). This is how the Group be ordered in 

the Alarm Group Dialog Box in VIEW and identified to Operators and Users.


7. Enter a Description for the group.  This will appear in the Alarm Group Dialog Box Dialog Box 

seen by users and operators in VIEW.


8. Select the Tag List in the left side, then choose the Tag List in the right side which shows 

the names of all Analog Tags and Discrete Tags to enter data into the Tag Name.
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9. Repeat step 8 to add more tag names.


10. Submit when you are finished.


11. There are two ways to download these changes to the SCADA Node:


Download and Restart the SCADA node from the SCADA Node properties page.  If you 

have never downloaded the SCADA node before, then this is required. This will 

temporarily stop the SCADA node (if it is running).


Use the Download hyperlink on the Alarm Group List Page. This will download changes to 

the Alarm Groups without stopping the SCADA node.


12. You can use update or delete on the Alarm Group List.


WebAccess/SCADA advanced Alarm Management System (AMS) delivers alarm messages 

via SMS, email or audio announcements to multiple receivers by predefined alarm groups, user groups, 

time schedules and priority settings.


1. Select your Project and the SCADA Node.


2. Hover Alarm ribbon button


3. Click Alarm Management System.


○

○

5.6 Alarm Management System


5.6.1 Entry
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Alarm Management System Configuration:


1. Define Holidays：Holiday handles exceptions to the 7 day weekly schedule. The "Holiday" is 

any unusual event or series of events. The Holiday setting can be defined, redefined and 

assigned at any time.


2. Define Time：Time has Workday and Holiday settings. Users can set the Working Start Time 

and Work hours for a Workday and Holiday schedule. Users can also define Time groups for 

different shifts.


3. Worker Maintenance：Assign worker information, like name, e-mail and phone number. 

Users can maintain the information.


4. Setup Worker Group：One or multiple workers, a single Time group and a Holiday group are 

assigned to each Worker Group. Worker Groups are groups of Workers that frequently share 

the same Time and Holiday Schedule to send an alarm to.


5. Alarm Group：Alarm Groups will build "Tags" that will always share the same Schedule to 

send the alarm.


6. Add Relationship：Connect the Worker Group and Alarm Group to share the same schedule 

with alarm tags to workers.


7. Download：Download the setting to the SCADA node. You can download the setting without 

stopping the SCADA node. The new setting will take effect immediately. If a tag is supposed 

to be ON, it will be set to the ON value.


Project users can add, modify, and download Alarm Management System from the Project 

Manager.


5.6.2 Configuration
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Holiday can be used for any calendar event or series of events, based on the Month, Day of 

Month and Year, up to 1 year in the future. Multiple schedules can be configured and assigned to 

different groups of tags.


Its typically usage is to create "Holiday" groups to have an "exception" to the normal weekday 

schedule. A Holiday Schedule can be created for any calendar event.


Holidays and exceptions to normal schedules are shown in RED. Click once on a date to add or 

remove a "holiday".


Group List ：A list of all configured Holidays.


Sort By：How Holiday Groups are sorted in the Group List: by Name, or by Number.


 Group Number：In the Group list, the Group Name is shown next to the Group Number.


 Group Name：In the Group list, the Group Number is shown next to the Group Name.


Group Number：A user defined number for the Holiday Schedule.


Entering a New number, not already specified, will create a new Holiday Group


5.6.2.1 Holiday


●

●

○

○

●

○
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Entering a number that already exists in group will try to overwrite or update the Holiday 

Group.


 Group Name：The user defined Name for this Holiday Schedule.


 Save ：Save without downloading the currently displayed Holiday Group, as the group 

number specified in Group Number.


If the group number does not exist, it will create a new Holiday Schedule. 


If the group number does exist, it will try to overwrite the existing group with this Holiday 

Schedule and description.


Delete：Delete the specified Holiday group, specified by the Group Number.


Each Worker Group has one Holiday Group assigned to it. This Holiday Schedule becomes the 

"exception" to the normal weekday schedule defined in each Worker Group. The same Holiday 

Group can be assigned to multiple Worker Groups.


Time defines the Work start time and Working hours for Workdays and Holidays. Users can 

define the Time group for different shifts. The same Time Schedule can be assigned to multiple 

Worker Groups.


Users can define different work times and hours for each Time Group to assign the alarm 

message to different Worker Groups based on the Time scheduler. The alarm tags will be 

managed and workers can immediately check the situation.


Users can build an unlimited number of Time Groups. For example, if you have multiple shift 

table for workers, they may each have their own Time Group. It's recommend to start out with 

one Time Schedule. If you are in need some day, just create a new Time Group.


Group List ：A list of all configured Times.


○

●

●

○

○

●

5.6.2.2 Time


●
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Sort By：Changes how Time Groups are sorted in the Group List: by Name or Number.


Group Number：In the Group list, the Group Name is shown next to the Group Number.


Group Name：In the Group list, the Group Number is shown next to the Group Name.


 Group Number： User defined numbers for the Time Schedule.


Entering a New number, not already specified, will create a new Time Group


Entering a number of an existing group will try to overwrite or update that Time Group.


Group Name：A user defined Name for this Holiday Schedule.


Time Period：Sets Work Start Time and Work Hours for Workday and Holiday


Work Start Time：Provides Time span every five minutes from 0:00 to 23:55


Work Hours：The unit is minutes. For example, 480 is for 8 hours ( 8*60 )


Save：Save without downloading the currently displayed Holiday Group.


If the Group number does not already exist, this will create a new Holiday Schedule. 


If the group number does exist, it will overwrite the existing group with this Holiday 

Schedule and description.


 Delete：Delete specified Holiday group, specified in Group Number.


Worker Maintenance builds workers information, such as name, e-mail and phone number. 

Users can maintain the information. The worker will be assigned to the Worker Group with the 

same Holiday and Time Group.


Add Worker：Build the worker information


●

○

○

●

○

○

●

●

■

■

●

○

○

●

5.6.2.3 Worker Maintenance
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Number：The number of the Worker. The worker list will list follow the number after 

submitting.


Name：The name of the worker


Phone number：The worker's phone number


E-mail：The worker's e-mail address


App Notification: Enable or disable to receive alarm push notification through mobile APP


Line: Enable or disable to receive alarm through Line


●

●

●

●

●

●
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WeChat: Enable or disable to receive alarm through WeChat


Company ID: WeChat Company ID


Application ID: WeChat Application ID


Application Secret: WeChat Application Secret


User ID: WeChat User ID


IFTTT: Enable or disable to receive alarm through IFTTT


Outgoing Email (SMTP) Server: IFTTT Outgoing Email (SMTP) Server


Email Port: IFTTT Email Port


Use SSL/TLS: IFTTT Use SSL/TLS


Email Address: IFTTT Email Address


Email Password: IFTTT Email Password


Submit：Save the information of the worker


Cancel：Cancels the building of the worker information and returns to the Worker List.


Users can Update and Delete the worker on Worker List page.


 

Update：Update the information


Delete：Delete the data of the worker


One or multiple workers, a single Time group and a Holiday group are assigned to each Worker 

Group. Worker Groups are groups of Workers that frequently share the same Time and Holiday 

Schedule to send an alarm to.


Add Worker Group：Add a new Worker Group


●

○

○

○

○

●

○

○

○

○

○

●

●

●

●

5.6.2.4 Set Worker Group
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Group No：The number of the Worker Group. The Worker Group list will follow this number 

once submitted.


Description：The description of the Worker Group


Worker List：The worker list provides a pull down menu of Worker names for easy data 

entry. Click the fields listed under the Worker and then open the Worker List by 

clicking  it.  Scroll down to find the Workers name. Click once on the Workers name to enter 

it into the selected Workers name field.


Holiday Group：Lists all Holiday Groups and assigns this Worker Group to the specified 

Holiday Group.       


Time Group：Lists all Time Groups and assigns this Worker Group to the specified Time 

Group. 


Worker：The column lists the Workers associated with this Worker Group.  


Submit：Saves the Worker Group. By only entering the Number users can submit the data.


Cancel：Cancels the building of the Group and returns to the Worker Group List.


Update：Update the information


Delete：Deletes the data of Worker Group


The Alarm Group connects to the Worker Group to send alarm messages with the same Holiday 

and Time Group. The alarm message of one tag can be received by multiple workers.


●

●

●

●

●

●

●

●

●

●

5.6.2.5 Setup Alarm Group
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Click Setup Alarm Group


Group Number：The Number of the Alarm Group. The next number in the Alarm Group is 

automatically assigned once the first is submitted.


Description：The description of the Alarm Group


Tag List：The Tag List provides a pull down menu of tag names for easy data entry. Click 

the fields listed under the Tag Name and then open the Tag List by clicking it.  Scroll down 

to find the tag name. Click once on the tag name to enter it into the selected tag name field.


Submit：Save the Alarm Group.


Cancel：Cancel building the Group and return to the Alarm Group List.


Update：Update the information


Delete：Delete the data of Alarm Group


Add Relationship means making the connection between the Worker Group and Alarm Group. 

The tags in the specified Alarm Group can send alarm messages to multiple receivers in the 

●

●

●

●

●

●

●

5.6.2.6 Add Relationship
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Worker Group with the specified Time and Holiday Group. Workers can manage the alarm 

situation of tags via the Time and Holiday schedule.


Click Add Relationship to set the connection between the Worker group and Alarm Group


Chose the connection of the specified Alarm Group and Worker Group


Delete：Delete the data of Alarm Group


                     


Schedule changes will be downloaded to the SCADA Node without stopping the SCADA node. 

This can be done from any configuration page in the Alarm Management system.


A dialog box prompts the user to confirm to download the schedule to SCADA Node.  All 

"submitted" changes made to the scheduler are downloaded.


All Manual ON or Manual OFF states are also downloaded.


To download a changed SCADA node from Project Manager:


 


1. Login to Project Manager.


2. Select Project and SCADA Node.


3. Select Scheduler from SCADA Node main page.


4. Make the desired changes in Holiday, Time, Worker Group, Alarm Group and the Relationship.


●

●

●

5.6.2.7 Download Schedule from Project Manager
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5. Submit.
6. Click to download to SCADA Node.


 


 Select OK at the dialog box to download the Scheduler.


1. Select your Project and the SCADA Node.


2. Click Report classification on node bar, then select Report.


3. You will see the Report List.


4. Select Add New Scheduled Report.


5. The Report configuration page appears.


5.7 Report

5.7.1 Configure Report
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6. Enter a Report Name. This is the name that will appear in the Scheduled Report List. This is 

a required field.

7. Optionally, fill in the Title for the Report. The Title consists of three lines of text at the Top 

of the Report.


8. Optionally enter an Email Subject. This is the subject Line that will appear in Emailed 

Scheduled Reports. The Date will be “pre-fixed” to this subject when sent. The tags from 

for the twelve (12) columns the report are entered in the Tag Name area, from 01 to 12.


9. Click on the 01 field.


10. Select the pull down list of tags at the right of Tag List. Only Analog Tags with Log to ODBC 

Frequency > 0 appear in the list.


11. Scroll down to the Tag Name to add data to column 1.


12. Repeat from fields 02 to 12 as desired.


13. Enable or Disable Shift Report, Daily Report and Monthly report by checking the radio 

button.
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14. If you are using Shift Report,


a. Enter the Shift Count (number of shifts per day).


b. Enter the Start Time for the first Shift (usually 8 hrs 0 minutes in the USA, 8:00 am).


c. Enter a Shift Duration (usually 8 hours if there are 3 shifts per day).


d. Enter a Recording Time Interval.  This applies to Shift reports only.


15. For Shift, Daily and Monthly Report:


a. Enter Email addresses of recipients in Email To. This will be combined with the Global 

Report Email TO in SCADA Node Properties. 


b. Enter Email CC (carbon Copy line). This will be combined with the global Report Email 

CC in SCADA Node Properties. Hint – Email To and CC fields can be a Text tag that 

contains the name(s) of email recipients (use @tagname) for use with the Scheduler to 

schedule who receives the reports by Time of Day, Day of Week, Holiday or calendar.


c. Use the radio buttons (Yes or No) to enable Print to Printer. This will print the scheduled 

report on the Default Printer of the SCADA Node. The report will print at the end of the 

shift, day or month.


d. Use the radio buttons (Portrait or Landscape) to enable Orientation of reports printed 

on a printer.


e. Use the pull down menus to select Font Size (Larger, medium, smaller).


f.  Enter a value for the Margins (top, left, right and bottom) of printed reports. If the 

report will not fit on a single page, Advantech WebAccess/SCADA will print multiple 

pages with the Title, Time, and summary data on each page


16. All three reports use the same Tags in the same columns. Different calculations (Average, 

Total, Min, Max, Last Value) can be performed in the Shift, Daily and Monthly Reports. These 

are specified under the Tag Property Button for each report.  The Titles of the Columns for 

the Reports are specified in the Tag Property for each report (a column represents one 

Tag’s data).  The three reports can have different Titles for each column or share the Titles 

based on another report (e.g. import Shift Report Titles to Daily, or Daily into Monthly). 


17. Enable printing to the default printer on the Project Node by checking the "Yes" radio button 
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under Print to Printer.


a. Modify Orientation (Landscape or Portrait)


b. Modify Font Size (uses fonts installed on the Project Node)


c. Modify Margins for the printing to a printer using


18. Continue to Shift Tag Property or Daily Report Tag Property or Monthly Tag Property (in the 

following sections).


19. Press Submit.


WebAccess/SCADA Excel reports are generated from the historical Data log, ODBC data 

(Analog, Discrete, and Text Tag), Alarm Log, Action log, and Event log based on the templates 

built by the data table and analysis charts as the report format in the WebAccess SCADA Node. 

Users & Operators can build customized report templates based on EXCEL functions and key 

words and uploaded in the WebAccess Excel report function to automatically generated 

daily/weekly/monthly or specific date reports. The function provide extensive analysis and 

viewing functions for statistical and event data. Reports are built using easy to follow “Report 

Template Forms” based on Excel format. View immediately in View DAQ via IE or local PC or 

store as “Predefined Reports” for later use.


Note：


Microsoft Excel version up to 2007


Windows XP only supports Daily/Weekly/Monthly report types


Support 32 tags and 7200 data


1. Start Advantech WebAccess/SCADA Project Manager.


2. Login with the User Name and Password and select your Project Name.


3. Click the SCADA node on Org chart.


4. Choose the EXCEL Report in Report ribbon：Go to the EXCEL report list page


Hint -   If you press submit without updating Tag Property for each report type, all values will 

be Averages and the Titles for each column will be blank.

5.8 Excel Report


●

●

●

5.8.1 Excel Report Configuration
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1. Start Advantech WebAccess/SCADA Project Manager.


2. Login with the User Name and Password and select your Project Name.


3. Click the SCADA node on Org chart.


4. Choose the EXCEL Report in Report ribbon：Go to the EXCEL report list page


5. Click New Report to create NEW EXCEL report


6. Configure the Report information


5.8.1.1 Data Log Type
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Report Name：Define the Report name. The maximum length of the name is 

32 alphanumeric characters and it can’t have spaces.


Log Type：Choose the source of Data Log Type. Support Data log, ODBC data (Analog, 

Discrete, and Text Tag), Alarm Log, Action log, and Event log.


Template：Default has four templates. Users can upload the predefined template to 

generate the report. Click the   icon to preview the template to check the template 

format.


○

○

○
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Report Type：The data type of report. Users can choose different data time types of 

report. There are six types, Self-defined, Last day, Last month, Multi-time, Daily Report, 

Weekly Report, Monthly Report


Start Time：The start time of the data of the report based on the Report type


End Time：The end time of the data of the report based on the Report type


Time Interval：Data time interval display in Report.


Time Unit：The Time unit of the Time interval.


Data Type：Choose to show the Last/Maximum/Minimum/Average value of time interval 

in the report.


Send E-mail：Choose send report to e-mail or not. Support Excel and PDF report file 

Type


Email To：Type Email receiver


Email Cc：Type Email Carbon Copy receiver





○

○

○

○

○

○

○

○

○

Note: Send E-mail, Email To, Email Cc only enable on Daily Report, Weekly Report, Monthly 

Report and Yearly Report.



182

7. Submit the New Report


8. Generate the Report：Click Generate to get the Report. If the report has been generated, 

the report link is shown in the View column.


Download：Download the Excel file


PDF：Export to PDF file.


Print：Report Print the report directly


Send E-mail：Send the report to e-mail receiver directly.


9. Update / Delete Report：Click Update and go to the update page


○

○

○

○
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Self-Defined reports provide users with the option to choose selg-defined time to generate the 

report.


Report Type：Self-Defined.


Start Time/End time：The start time and end time of the time period.


Time Interval：Time interval of all time periods.


Note：

1. One report can gather a maximum of 32 tags and 7200 records.

2. The report backup is in C:\inetpub\wwwroot\broadweb\WaExlViewer\report

1. Self-Defined Reports


●

●

●
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Users can get the report based on the data with the day before the day of the WebAccess 

system from 0:00 to 24:00. The default start time and end time are already set when user 

chooses this report type.


2. Last day Report type
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Users can get the report based on the data with the last month of the WebAccess system. The 

default start time and end time are already set when the user chooses this report type.


3. Last Month Report type
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Daily reports are automatically generated based on the defined time period every day. The 

report list will show each daily report and view the report.


The daily report also can be generated manually in the report list at any time.


4. Daily Report
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Weekly reports are automatically generated based on the defined time period every week. The 

report list will show each weekly report and view the report.


The weekly report also can be generated manually in the report list at any time.


5. Weekly Report
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Monthly reports are automatically generated based on the defined time period every month. The 

report list will show each weekly report and view the report.


The monthly report also can be generated manually in the report list at any time.


6. Monthly Report
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Yearly reports are automatically generated based on the defined time period every year. The 

report list will show each yearly report and view the report.


The yearly report also can be generated manually in the report list at any time.


7. Yearly Report
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1. Start Advantech WebAccess/SCADA Project Manager.


2. Login with the User Name and Password and select your Project Name.


3. Click the SCADA node on Org chart.


4. Choose the EXCEL Report in Report ribbon：Go to the EXCEL report list page


5.8.1.2 ODBC Log Configuration
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5. Click New Report to create NEW EXCEL report


6. Configure the Report information
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Report Name：Define the Report name. The maximum length of the name is 

32 alphanumeric characters and it can’t have spaces.


Log Type：Choose the source of ODBC Data Type. Support Data log, ODBC data (Analog, 

Discrete, and Text Tag), Alarm Log, Action log, and Event log.


ODBC Log Data Source : Choose the source of ODBC DSN.


Template：Default has four templates. Users can upload the predefined template to 

generate the report. Click the   icon to preview the template to check the template format.


●

●

●

●
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Report Type：The data type of report. Users can choose different data time types of 

report. There are six types, Self-defined, Last day, Last month, Multi-time, Daily Report, 

Weekly Report, Monthly Report


Start Time：The start time of the data of the report based on the Report type


End Time：The end time of the data of the report based on the Report type


Time Interval：Data time interval display in Report.


Time Unit：The Time unit of the Time interval.


Data Type：Choose to show the Last/Maximum/Minimum/Average value of time interval 

in the report.


Send E-mail：Choose send report to e-mail or not. Support Excel and PDF report file 

Type


Email To：Type Email receiver


Email Cc：Type Email Carbon Copy receiver





○

○

○

○

○

○

○

○

○

Note: Send E-mail, Email To, Email Cc only enable on Daily Report, Weekly Report, Monthly 

Report and Yearly Report.
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7. Submit the New Report


8. Generate the Report：Click Generate to get the Report. If the report has been generated, 

the report link is shown in the View column.


Download：Download the Excel file


PDF：Export to PDF file.


Print：report Print the report directly


9. Update / Delete Report：Click Update and go to the update page


○

○

○
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1. Start Advantech WebAccess/SCADA Project Manager.


2. Login with the User Name and Password and select your Project Name.


3. Click the SCADA node on Org chart.


4. Choose the EXCEL Report in Report ribbon：Go to the EXCEL report list page


Note：

1. One report can gather a maximum of 32 tags and 3600 records.

2. The report backup is in C:\inetpub\wwwroot\broadweb\WaExlViewer\report

5.8.1.3 Alarm Log Configuration
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5. Click New Report to create NEW EXCEL report


6. Configure the Report information
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Report Name：Define the Report name. The maximum length of the name is 

32 alphanumeric characters and it can’t have spaces.


Log Type：Choose the source of Alarm Log Type. Support Data log, ODBC data (Analog, 

Discrete, and Text Tag), Alarm Log, Action log, and Event log.


ODBC Log Data Source : Choose the source of ODBC DSN.


Template：Default has four templates. Users can upload the predefined template to 

generate the report. Click the   icon to preview the template to check the template 

format.


Report Type：The data type of report. Users can choose different data time types of 

report. There are six types, Self-defined, Last day, Last month, Multi-time, Daily Report, 

Weekly Report, Monthly Report


Start Time：The start time of the data of the report based on the Report type


End Time：The end time of the data of the report based on the Report type


Filter：


Priority：Set Alarm Priority. User can type the range with (-) and (,), ex, 0-80, 88, 90.


Alarm Group：Choose Alarm group. User can type the range with (-) and (,).


Worker Name：WebAccess User Name


Project Node Name：Project Node Name


Project Node IP Address：Project Node IP Address


Sort By：Sort by Time/Tag/Priority/Alarm Group


Time Interval：Data time interval display in Report.


Time Unit：The Time unit of the Time interval.


Data Type：Choose to show the Last/Maximum/Minimum/Average value of time interval 

in the report.


Send E-mail：Choose send report to e-mail or not. Support Excel and PDF report file 

Type


Email To：Type Email receiver


Email Cc：Type Email Carbon Copy receiver





7. Submit the New Report


8. Generate the Report：Click Generate to get the Report. If the report has been generated, 

the report link is shown in the View column.


○

○

○

○

○

○

○

○

○

○

○

○

○

○

○

○

○

○

○

○

Note: Send E-mail, Email To, Email Cc only enable on Daily Report, Weekly 

Report, Monthly Report and Yearly Report.
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Download：Download the Excel file


PDF：Export to PDF file.


Print：Report Print the report directly


Send E-mail：Send the report to e-mail receiver directly.


9. Update / Delete Report：Click Update and go to the update page











1. Start Advantech WebAccess/SCADA Project Manager.


2. Login with the User Name and Password and select your Project Name.


3. Click the SCADA node on Org chart.


4. Choose the EXCEL Report in Report ribbon：Go to the EXCEL report list page


○

○

○

○

Note：

1. One report can gather a maximum of 32 tags and 7200 records.

2. The report backup is in C:\inetpub\wwwroot\broadweb\WaExlViewer\report

5.8.1.4 Action Log Configuration
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5. Click New Report to create NEW EXCEL report


6. Configure the Report information


Report Name：Define the Report name. The maximum length of the name is 

32 alphanumeric characters and it can’t have spaces.


Log Type：Choose the source of Action Type. Support Data log, ODBC data (Analog, 

Discrete, and Text Tag), Alarm Log, Action log, and Event log.


ODBC Log Data Source : Choose the source of ODBC DSN.


Template：Default has four templates. Users can upload the predefined template to 

generate the report. Click the   icon to preview the template to check the template format.


●

●

●

●
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Report Type：The data type of report. Users can choose different data time types of report. 

There are six types, Self-defined, Last day, Last month, Multi-time, Daily Report, Weekly 

Report, Monthly Report


Start Time：The start time of the data of the report based on the Report type


End Time：The end time of the data of the report based on the Report type


Filter：


Worker Name：WebAccess User Name


Project Node Name：Project Node Name


Project Node IP Address：Project Node IP Address


Tag：Tag recorded Action


Send E-mail：Choose send report to e-mail or not. Support Excel and PDF report file Type


Email To：Type Email receiver


Email Cc：Type Email Carbon Copy receiver





7. Submit the New Report


8. Generate the Report：Click Generate to get the Report. If the report has been generated, 

the report link is shown in the View column.


●

●

●

●

●

●

●

●

●

●

●

Note: Send E-mail, Email To, Email Cc only enable on Daily Report, Weekly Report, Monthly 

Report and Yearly Report.
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Download：Download the Excel file


PDF：Export to PDF file.


Print：Report Print the report directly


Send E-mail：Send the report to e-mail receiver directly.


9. Update / Delete Report：Click Update and go to the update page











1. Start Advantech WebAccess/SCADA Project Manager.


2. Login with the User Name and Password and select your Project Name.


3. Click the SCADA node on Org chart.


4. Choose the EXCEL Report in Report ribbon：Go to the EXCEL report list page


5. Click New Report to create NEW EXCEL report


○

○

○

○

Note：

1. One report can gather a maximum of 32 tags and 3600 records.

2. The report backup is in C:\inetpub\wwwroot\broadweb\WaExlViewer\report

5.8.1.5 Event Log Configuration
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6. Configure the Report information


Report Name：Define the Report name. The maximum length of the name is 

32 alphanumeric characters and it can’t have spaces.


Log Type：Choose the source of EventLog Type. Support Data log, ODBC data (Analog, 

Discrete, and Text Tag), Alarm Log, Action log, and Event log.


Template：Default has four templates. Users can upload the predefined


Report Type：The data type of report. Users can choose different data time types of 

report. There are six types, Self-defined, Last day, Last month, Multi-time, Daily Report, 

Weekly Report, Monthly Report


Start Time：The start time of the data of the report based on the Report type


End Time：The end time of the data of the report based on the Report type


Time Interval：Data time interval display in Report.


Time Unit：The Time unit of the Time interval.


Data Type：Choose to show the Last/Maximum/Minimum/Average value of time interval 

in the report.


7. Submit the New Report


○

○

○

○

○

○

○

○

○



203

8. Generate the Report：Click Generate to get the Report. If the report has been generated, 

the report link is shown in the View column.


Download：Download the Excel file


PDF：Export to PDF file.


Print：Report Print the report directly


Send E-mail：Send the report to e-mail receiver directly.


9. Update / Delete Report：Click Update and go to the update page











Users & Operators can build customized report template based on EXCEL functions and key 

words and upload in WebAccess Excel report function to automatically generated 

daily/weekly/monthly or the specific date report.


1. Open the Microsoft office EXCEL


2. Rename Sheet 1 to “template”. WebAccess's Excel Report function identifies the name 

○

○

○

○

Note：

1. One report can gather a maximum of 240 records.

2. The report backup is in C:\inetpub\wwwroot\broadweb\WaExlViewer\report.

5.8.2 Build the Template
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"template" as the sheet to be the report template.


3. Key in the key words about Time / Tag / Project/Node information. Save the file and the file 

name will be the name of Template in the WebAccess


4. Upload the template in the system：New Template


Upload Template：Upload the pre-built template.


Description：The description of the template


Upload Preview：Upload the preview picture. The picture will show up when users create 

the new report and click the icon to preview the template.


Submit：Submit and upload the template.


○

○

○

○
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5. Template list：List all templates. The template list includes four default templates and the 

new uploaded templates. The template list based on the upload date.


6. Update the template：Click Update in the Template list and change the template 

information.


1. Go to Report list.


2. Click Generate to generate and view the report for the new report.


3. Click View link to view the old report.


4. For Daily/Weekly/Monthly/Yearly report, the reports are automatically generated 

Daily/Weekly/Monthly/Yearly with the file name ”Daily/Weekly/Monthly/Yearly Report_ 

Date” and list in the View link. Choose one report and click to open.


        You  can also click "Generate" in the report list at any time.


WebAccess now allows users to create map files that contain markers on Google Map or Baidu 

Map. A marker contains Icons which can be displayed according to the value of a tag. A marker 

also contains a title and up to three label/value combinations to be displayed as the marker 

information. And a left-click Macro can also be associated with a marker.


 


5.8.3 View Report

5.8.3.4 View in Report list


5.9 Map




206

The map list dialog box can be accessed via Map menu item under Tools for map files already 

created and downloaded to be displayed in ViewDAQ or View Client.


1. Select your Project and the SCADA Node.


2. Click Map classification on node bar.


3. The window will connect and show Google Map.


4. Click New to create the new map.


5. Choose the location.


6. Click twice on the location to add the Marker Information, and the window will show 

the configuration tool.


5.9.1 WebAccess Map Configuration
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7. Type the title. The marker can’t save without the title.


8. When choosing the location, the Latitude and Longitude of the location will be shown on the 

Marker information.


9. Go to the Image, click the ADD.


10. ADD: you can upload images as icons in the map, the notice is the file of image must be less 

than 10 KB. If you want to delete the image you uploaded, click Remove under the image.




208

11. The marker’s image can change with the measure value. First, click the image and 

give Value to the image. The value can be one or more number, the range and mix the 

number and range. When running the WebAccess, the tag value get the set value, the image 

will be shown on the map.


12. Type the Tagname and Left click Macro.


13. Click Save on the Marker Information. The image and title will be shown on the map.


14. Change the marker information. Click the image on the map, and the window of marker 

information will pop up.


15. Change the location of the marker. Use the mouse to drag the image to new location. Add 

more marker information. Click More on the Marker information to add three text labels. As 

for the picture, there are three  labels, one Label has one Label name and Tagname.
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Label Name : The Name of label


Tag Name  : Type the Tag Name to connect the Web access node, if the name is the same as 

the tag             node. The marker can show the value of the tag node on the map after typing 

the Tagname.


Normal / Alarm / Alarm Ack  : Select Colors and blink for Normal, Alarm and Alarm 

ACK State to             display Alarm Status with Tag Name.


16. Click the maker and select Remove to delete this maker.


17. Save map: After creating tag locations, click Save on the top bar of map. Type the Map 

Name and click OK. After saving, the coordinate of the center and ration will become the 

default.


18. Delete Map : Click Delete to cancel the map on the screen and the saved map. 


19. Download map: Click Download to download the map to the DAQ. View DAQ will update the 

map.


●

●

●
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20. Excel-In: 

Choose Excel In.


Choose the import Excel file.


The file will list in the page after uploading, and display map name and number of markers.


21. Excel-Out:

Choose Excel Out.


Maps files are list in the page and choose export file.


●

●

●

●

●
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Click Submit. The Export file will be in the defined path.


1. Select your Project and the SCADA Node.


2. Click Server classification on node bar, then select BACNet Server.


3. If this is the first time to configure BACNet Server, you will see the BACNet Server Page.


●

5.10 BACNet Server

5.10.1 Configure BACNet Server
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4. Click Create BACNet Server button.


5. The BACNet Server configuration page pops up.


6. Fill the basic information and APDU fields, then press SUBMIT. BACNet Server is already 

created.


7. After create BACNet Server, you will see the BACNet Server Object List . 


8. You can press the icon "..." to Edit Server or Reset Setting.





9. Then configure Objects, if necessary.


Note - if you Reset Setting ,all the object settings will be cleared.
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10. There are AI, AO, AV, BI, BO, BV, MI, MO, MV, Notification and Accumulator object type on 

the left side.


11. Choose the object type you want, then click Insert on the top bar.


12. The BACNet Object configuration page pops up.


13. Fill the fields and SUBMIT data, object create successfully.


14.  You can Edit or Delete the objects on the Modbus Server Object List.


1. Select your Project and the SCADA Node.


2. Click Server classification on node bar, then select Modbus Server.


3. You will see the Modbus Server List . Serial port type is in left tab, and TCP/IP port type is in 

right tab.


5.11 Modbus Server

5.11.1 Configure Modbus Server
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4. Choose the port type you want and click Insert, then you will see different field.
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5. If you choose port type SERIAL, you need to fill Comport, Description, Baud Rate, Data 

Bit, Stop Bit, Parity,  Device Address and ENABLE_EXCEPTION fields. 





6. If you choose port type TCP/IP, you need to fill TCP 

port, Description and ENABLE_EXCEPTION fields.





7. After you finish the basic information of modbus port, you can click Tag List, if necessary.


8. The Modbus Server Tag List page appears.


9. Click ADD, the Modbus Server Tag configuration page appears .


  Note - The Comport Number must be an unique number.

  Note - The TCP port must be an unique number.
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10. Fill the Modbus Address,  Tag Name and Data Type. You need to input Text Length when 

you choose the TEXT data type. 


11. Click Submit when you are finished.


12. You can use Edit or Delete on the Modbus Server List.


1. Select your Project and the SCADA Node.


2. Click Program classification on node bar, then select Global Script.


3. You will see the Global Script List.


5.12 Global Script

5.12.1 Configure Global Script
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4. Select Insert.

5. The Global Script configuration page appears.




218
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6. Description is any user-defined description for this group of scripts.


7. Select Start Script if you want a script to run when the SCADA node starts. This script will 

run once when the SCADA node starts or restarts.This file must be located in the project 

root directory, typically c:\WebAccess\node\config\projectname\bgr. Scripts are built 

using the Script Editor in DRAW.


8. Select Stop Script to specify a script to run when the SCADA node is stopped or stopped as 

part of a restart. This acts as a Shutdown Script.  The Stop script runs when the SCADA 

Node is stopped using either bwkCTRL, the task bar menu or Project Manager.


9. Select Running Script if you want a script to run repeatedly at specified Interval while 

the SCADA node is running . The While Running Script runs continuously on the SCADA 

Node ( as long as the kernel is running).


10. Type an Interval for the While Running Script.  These are in 25 millisecond intervals.  10 = 

0.25 sec = ¼ second 2400 = 60 sec = 1 minute.


11. Select ENABLE for the STATUS.


12. There are two ways to download these changes to the SCADA Node:


a. Download and Restart the SCADA node from the SCADA Node properties page.  If you 

have never downloaded the SCADA node before, then this is required. This will 

temporarily stop the SCADA node (if it is running).


b. Use the Export on the Global Script List Page. This will download changes to the Global 

Script without stopping the SCADA node.


5.12.2 Configure Global Script


This data can also be viewed in runtime using the Global Script System Display or  %DGSST, 

%TGSSCRPT1, %TGSSCRPT2 and %TGSSCRPT3.

5.12.3 Global Script INI file


This information is stored in a Global Script Initialization file which is downloaded to the SCADA 

node. You can view this file a drive:\WebAccess\Node\config\Project_Node\BWSCRRDT.INI on 

the Project Node or drive:\WebAccess\Node\Project_NodeBWSCRRDT.INI on the SCADA node


[ssnumber] A group of three scripts: Start, While Running and Stop controlled by same STATUS 

flag.


 


DESCRIPTION  - Any user description for the group of three scripts


 


Start Script  - Optionally, this Script runs only once on START of the SCADA node. It will run 

once if the STATUS=1=ENABLE. This defines the name of the script file (the script.scr).


This file must be located in the project root directory, typically 

C:\WebAccess\Node\config\projectname\bgr
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Stop Script  - Optionally, this Script runs only once on STOP of the SCADA node. It will run once 

if the STATUS=1=ENABLE. This defines the name of the script file (the script.scr).


This file must be located in the project root directory, typically 

C:\WebAccess\Node\config\projectname\bgr


 


Running Script  - This Script Runs Continuously. This defines the name of the script file (the 

script.scr).


This file must be located in the project root directory, typically 

C:\WebAccess\Node\config\projectname\bgr


 


INTERVAL  - The frequency it runs at (in 25 milliseconds, 0.025 seconds, 20 = once every 1/2 

second, 40 = once every  1 seconds, 240=6 seconds, 400 = once every 10 seconds, 1200=30 

seconds, 2400=every 21 minutes)


 


STATUS  - Enables of Disables the entire block of System Scripts. 0=all three scripts Startup, 

While Running and Shutdown are disabled (will not run).


1= enables the SCADA System Scripts in this block (i.e. all scripts defined under the [ssnumber} 

tag).


The SCADA node can call a custom User Program or any third party program including *.exe and 

*.bat files. These 3rd party programs are called when the SCADA Node starts.


 


You can use Scripts to schedule User Programs based on calendar or time-of-day or events 

using the WINEXEC Action Command.


1. Connect to Advantech WebAccess/SCADA Project Node.


2. Start Configuration.

3. Login to Project Manager.


4. Select the SCADA node.


5. Click Program classification on node bar, then select User Program.


5.13 User Program Configuration


5.13.1 Configure User Program
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6. The User Program configuration page appears.


7. Enter the full path and program name.





8. Click Enable if you want the program to run when the SCADA node starts.


Similar in concept to a Sequence of Events Recorder, The Event log will log user-defined 

number of sample before the event and after the event. The data is logged to an ODBC database 

on the Project Node.  


1. Select your Project and the SCADA Node.


2. Click Log classification on node bar, then select Event Log.


3. You will see the Event Log List.


Note - if you copy your User Program to C:\WebAccess\Node\config\Projectname_Nodename 

, you do not need to enter the full path here.

5.14 Event Log


5.14.1 Configure Event Log
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4. Click Insert.


5. The Event Log configuration page appears.


6. Enter an Event Log Name (no blank spaces).


7. Optionally, enter a Description.


8. Click once on the Event Tag field, then use the pull down Tag List to select a tag. The Event 

Tag is the tag which will cause logging to start. It can be an Analog or Discrete Tag.  It can 

also be a  Calculation Tag if you need a complex relationship to start logging.


9. Select the Event Type from the pull down list.


Event Types that will trigger logging include:


Event Tag >= Reference Value


Event Tag <= Reference Value


Event Tag == Reference Value


○

○

○
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Event Tag >= Reference Tag


Event Tag <= Reference Tag


Event Tag == Reference Tag


Record Every Sample Interval


9. If Event Tag >= Reference Tag or Event Tag <= Reference Tag is selected, then click once 

on the Reference Tag field then use the pull down Tag List to select a tag.  Alternatively, you 

can type the tag name or copy and paste in a tag name.


10. Select an ODBC Log Data Source to store the event log.


11. Enter a Dead band.  This is the Percent of Span that is considered big enough to start 

logging.


12. Enter a Sample Interval.  This is the frequency of logging.





13. Enter the Number of Sample before the Event to be recorded.  This is to see what lead up to 

the event and helps to diagnose what caused the event.


14. Enter the Number of Samples After the Event to be recorded. Choose Log Continuously to 

record the event data from the event began until  the event ends.


15. Select the Event Log Tags tab. The second page of the Event Log Tags Setup  page appears.


16. Use the Max Tags pull down list to increase or decrease the number of tags from 2 to 240.


○

○

○

○

Note - the Sample Interval is a function of this entry and the specified Scan Time for the 

communication port  and the effective Scan Time (e.g. how fast the PLC or IO actually can be 

polled or scanned).
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17. Click tags and Click Click here to ADD from the pull down Existing List to select a 

tag.  Alternatively, you can type the tag name or copy and paste in a tag name.


18. Repeat step 17 to add more tags.





Up to 22 Tags can be logged to a single Event Log based on the status of a single tag (the Event 

Tag). 


Multiple Event Logs can be configured if you need multiple tags to trigger logging.


Resolution can be from 1 millisecond to 1 hour.  The Actual resolution depends on you computer 

hardware, network connections and communications to field device (e.g. PLC)  


The record time of Event Log data (i.e. Record every sample period) now aligns to 00:00:00 

regardless of when the SCADA node started. For example, if you specify recording every 10 

seconds, then the data will record on :00, :10, :20, :30, :40 and :50 seconds after the minute for 

the duration specified.


Note - Max Size will affect this one Event Log.  Changing the Size of this Event Log will result 

in the data table being re-created to increase the number of columns.  This will delete all 

previous data for this one Event Log the next time the SCADA Node is downloaded and 

restarted. A dialog box opens to warn you that changing the size of the event log will delete 

previously logged data.

Note - Optionally, you can also enter the name of a Script to run. This should be used with 

caution since it can affect system performance if fast recording of live data is also required. 

The names with extensions ".SCR", ".JS" or ".VBS"  are treated as a script file names. When 

the event is triggered, the script(s) will be executed and a value "0" will be recorded in event 

log. The scripts should be located in the \bgr sub directory for the project and node.
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19. You can use Edit or Delete on the event Log List.


1. Select your Project and the SCADA Node.


2. Click Log classification on node bar, then select Custom Table Log.


           


3. You will see the Custom Table Log List.


                            


4. Click Insert.


5. The Customized Database Schema Configuration page appears.


5.15 Custom Table Log

5.15.1 Configure Customized Database Schema
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6. You can design the column details like column type in Table Design.


7.  You can Edit or Delete the objects on the  Custom Table Log List.


5.16 MQTT Connection Setting
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MQTT Connection Setting has two parts:


WebAccess MQTT Connection Settings


WISE-PaaS Connection Settings


Click SCADA Node on Org Chart.


Hover More Connector on the Ribbon.


WebAccess/SCADA is dedicated to offer the comprehensive solutions to meet our customers' 

needs. WebAccess Cloud Connection is an integrated Internet of Things (IoT) solution which 

provides various types of services such as data communication, data synchronization, IoT 

administration.


Click WebAccess MQTT Connection Settings.


Configuring the connection information on the Connection Setting.


●

●

5.16.1 Entry

●

●

5.16.2 WebAccess MQTT Connection Settings


5.16.2.1 Editing Connection Setting


●

●
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Connection setting properties:


Enable: the connection status with the Boolean attribute, Enable property can be set to keep 

a cloud connection until the connection attribute is disable.


Cloud Project Name: The cloud project name.


Cloud Node Name: The cloud SCADA node name.


Primary Device ID: The cloud device identity with unique value. The default value is “Cloud 

Project Name _ Cloud SCADA Node Name”


IP Address: The MQTT broker connection address such as domain name (e.g., WebAccess) 

or IP address (172.18.3.157).


Comport Number:


TCP comport-1883


TLS comport-8883


Windows 7 (or earlier version):


WebSocket and SSL - 51329


WebSocket and Non-SSL= 51328


Windows 8 (or above version):


WebSocket and SSL -443


WebSocket and Non-SSL=80














●

●

●

●

●

●

Note –

1) WebSocket and SSL

2) WebSocket and Non-SSL

For above two comports, they need to be set in Windows 7 (or earlier version), while Windows 

8 (or above version) do not need to be set.
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Connection Type: MQTT connection type: using webscocket and TCP.





Use SSL/TLS: A Boolean attribute to distinguish use and non-use the SSL/TLS on MQTT 

broker connection.


MQTT broker User Name: The authorized MQTT broker user’s name


MQTT broker Password: The authorized MQTT broker user’s password


Keep-Alive Interval: the keep-alive interval is used to maintain the connection with the 

broker and retry for delivering messages.


Data Publish Interval (second): Setting the time interval to publish the data. The kernel will 

publish data according to this interval.


Publish Data via Value Changed: A Boolean attribute to determine the way to send data. 

Select “Yes” means send data to MQTT broker when value changed. Select “No” means to 

send data to MQTT broker by data publish time interval, no matter the data value changed or 

not.


Publish Data at Kernel Startup: A Boolean attribute to determine when devices will start to 

send the data. Select “Yes” means data start to be sent when the kernel startup. Select 

“No” means data will not be sent until the kernel received start-to-send command from the 

MQTT Broker.





Using WebAccess cloud white-list, users can configure the tag on the ground project.


●

Note-MQTT broker in Win7 ( or Earlier version) only can connect with TCP type.

●

●

●

●

●

●

●

Note –The device ID is critical for cloud device, as the device ID is unique for each 

record.  The MQTT broker user name and the MQTT broker password must be consistent with 

the MQTT broker setting on the cloud project.

5.16.2.2 Editing the MQTT white list
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Find the Tag you want to edit:


Click Tags, you can see different node types like Acc Point. Select one node type, the 

tags which are belonged to the node type will show  in the list.


Click Selected, the tags was set selected will show in the list.


Using the search under Tags/Selected tab.


Click Edit in tag list, then click submit to save your change.


User can set the tag property in cloud white-list, and the cloud white-list has configurable 

properties including dead band, RTDB and upload. The tag can upload to the cloud project by 

setting the white list. The following Parameters appear for a cloud white-list configuration:


●

○

○

○

●
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The cloud white-list properties


Click WISE-PaaS MQTT Connection Settings.


Configuring the connection information on the WISE-Paas MQTT Connector.


Note –The first column is the “upload” property. If you want to update the tag to the cloud 

device, the checkbox of first column must be checked.  

●

5.16.3 WISE-PaaS Connection Settings

5.16.3.1 Editing Connection Settings


●

Property Name
 Description
 Type


Upload
 Enabling to uploading to the  

cloud


Checkbox


Tag name
 Tag name
 The default  string


Dead band
 The threshold (percentage) 

of  difference between the 

current and last published 

value.


Textbox


Real time database log  

(RTDB)


Enabling to log in the  RTDB
 Checkbox


Description
 The description of  tag
 The default  string
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Connection setting properties:


Enable: the connection status with the Boolean attribute, Enable property can be set to keep 

a cloud connection until the connection attribute is disabled


Connection Type: select to connect with WISE-PaaS (DCCS) or Azure


[While selecting DCCS]


Node ID: The unique ID of the SCADA


Credential Key: the credential key is used to access DCCS


DCCS API URL: Provides Edge Device to quickly obtain credentials and connect to WISE-

PaaS platform


[While selecting Azure]


Device ID: The unique ID of the SCADA


Host Name: Azure IoTHub host name or IP address


SAS Token: Connection secret key for data encryption


[Common setting]


Keep-Alive Interval: the keep-alive interval is used to maintain the connection with the 

broker and retry feature for delivering messages


Data Publish Interval (second):Setting the time interval to publish the data. The kernel will 

publish data according to this interval.


Publish Data via Value Changed: A Boolean attribute to determine the way to send data. 

●

●

●

●

●

●

●

●

●

●

●
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Select “Yes” means send data to MQTT broker when value changed. Select “No” means to 

send data to MQTT broker by data publish time interval, no matter the data value changed or 

not.





The WISE-PaaS white-list link is found on the top side of the SCADA node setting. Using 

WebAccess cloud white-list, users can configure the tag on the ground project.


On the WISE-PaaS Connection Setting, you can search the selected tag:


Select the node type (via the left menu)


Note –The device ID is critical for cloud device, as the device ID is unique for each record.

5.16.3.2 Editing the WISE-PaaS white list


●

●
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Click the device name -> the tag lists of each device is display the right screen -

>Modify the whitelist attribute -> Click Submit








●

Note –You can select all tags in the specific attribute by checking the checkbox in the column 

title.

Select All:
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The user can set the tag property in the cloud white-list, and the cloud whitelist has 

configurable properties including dead band and upload. The tag can upload to the cloud 

project by setting the white-list. The following parameters appear for a cloud white-list 

configuration:





 


 The cloud white-list properties


●

Note –The first column is the “upload” property. If you want to update the tag to the cloud 

device, the checkbox of the first column must be 

checked                                                                                      

●

Property Name
 Description
 Type


Upload
 Enabling to uploading to the  

cloud


Checkbox


Tag Type
 The type of tag
 The default  string


Tag name
 Tag name
 The default  string


Description
 The description of  tag
 The default  string


Dead band
 The threshold (percentage) 

of  difference between the 

current and last published 

value.


Textbox


Scan Type
 The type of scanning
 Drop Down List
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Then download the SCADA node and start the kernel.


AWS IoT is a managed cloud platform that lets connected device easily and securely interact 

with cloud applications and other device.


1. Click AWS Connection Settings.


2. Configuring the connection information on the Connection Setting.


5.16.4 AWS Connection Settings


5.16.4.1 Editing Connection Setting
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Connection setting properties:


Enable: the connection status with the Boolean attribute, Enable property can be set to keep 

a cloud connection until the connection attribute is disable.


Endpoint: Enter your custom endpoint that allows you to connect to AWS IoT. This is an 

●

●
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important property to insert when using an MQTT client.


Thing Name: An IoT thing is a representation and record of your physical device in the cloud. 

Any physical device needs a thing record in order to work with AWS IoT.


Certificates File: A certificate for this thing.


Private Key File: A private key for this thing.


Root CA File: A Root CA for this thing.


Data Publish Interval (second):Setting the time interval to publish the data. The kernel will 

publish data according to this interval.


Publish Data by Value Changed: A Boolean attribute to determine the way to send data. 

Select “Yes” means send data to MQTT broker when value changed. Select “No” means to 

send data to MQTT broker by data publish time interval, no matter the data value changed or 

not.


3. Press Submit.


The AWS white-list link is found on the top side of the SCADA node setting. Using WebAccess 

cloud white-list, users can configure the tag on the ground project.


●

●

●

●

●

●

5.16.4.2 Editing the AWS white list
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On the AWS Tag Whitelist, you can search the selected tag:


Select the node type (via the left menu)


●

●
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Click the device name -> the tag lists of each device is display the right screen ->Modify 

the whitelist attribute -> Click Submit


●
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The user can set the tag property in the cloud white-list, and the cloud whitelist has 

configurable properties including dead band and upload. The tag can upload to the cloud 

project by setting the white-list. The following parameters appear for a cloud white-list 

configuration:





 


 The cloud white-list properties


Note –You can select all tags in the specific attribute by checking the checkbox in the column 

title.

Select All:

●

Note –The first column is the “upload” property. If you want to update the tag to the cloud 

device, the checkbox of the first column must be checked              

                                                                        

●
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Then download the SCADA node and start the kernel.


Aliyun Connection is an integrated Internet of Things (IoT) solution which provides various types 

of services such as data communication, data synchronization, IoT administration.


Clicked Setup.


5.16.5 Aliyun Connection Setting


5.16.5.1 Editing Connection Setting


●

Property Name
 Description
 Type


Upload
 Enabling to uploading to the  

cloud


Checkbox


Tag Type
 The type of tag
 The default  string


Tag name
 Tag name
 The default  string


Description
 The description of  tag
 The default  string


Dead band
 The threshold (percentage) 

of  difference between the 

current and last published 

value.


Textbox
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Connection setting properties:


Enable: the connection status with the Boolean attribute, enable property can be set to keep 

a cloud connection until the connection attribute is disabled


Region ID: The region ID is a code of geographic area where a data center resides. (Default: 

0)


Region ID Custom: The Region ID custom is a geographic area where a data center resides.


Port: The default value is 443 with TLS.(Default: 0)


Product Key: The product key is the unique identifier of a product in IoT Platform. This 

parameter is used in device authentication and communication.


Product Secret: The product secret is the private key issued by IoT Platform for each 

product and usually used in pair with the Product Key for unique-certificate-per-product 

authentication.


Device Name: The device name is automatically generated or defined by the user during 

device registration.


Device Secret: The device secret is the private key issued by IoT Platform for each device 

and used in pair with device name. You could pass this column if the Dynamic Register was 

●

●

●

●

●

●

●

●
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selected “Yes”.


Dynamic Register: A Boolean attribute to determine the way to register the Device Secret. 

Select “Yes” means register Device Secret dynamically. (Default: No)


Data Publish Interval (second): Setting the time interval to publish the data. The kernel will 

publish data according to this interval. (Default: 0)


Publish Data by Value Change: A Boolean attribute to determine the way to send data. Select 

“Yes” means send data to Aliyun when value changed. Select “No” means to send data to 

Aliyun by data publish time interval, no matter the data value changed or not. (Default: No)


The Aliyun white-list link is found on the top side of the SCADA node setting. Using WebAccess 

cloud white-list, users can configure the tag on the ground project.


On the Aliyun Connection Setting, you can search the selected tag:


Select the node type (via the left menu)


●

●

●

5.16.5.2 Editing the Aliyun white list


●

●
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Click the device name -> the tag lists of each device is display the right screen -> Modify 

the whitelist attribute -> Click Submit








●

Note - You can select all tags in the specific attribute by checking the checkbox in the column 

title.

Select All:
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The user can set the tag property in the cloud white-list, and the cloud whitelist has 

configurable properties including dead band and upload. The tag can upload to the cloud 

project by setting the white-list. The following parameters appear for a cloud white-list 

configuration:





The cloud white-list properties


Then download the SCADA node and start the kernel.


●

Note – The first column is the “upload” property. If you want to update the tag to the cloud 

device, the checkbox of the first column must be checked

●

Property Name
 Description
 Type


Upload
 Enabling to uploading to the  

cloud


Checkbox


Tag Type
 The type of tag
 The default  string


Tag name
 Tag name
 The default  string


Description
 The description of  tag
 The default  string


Array Size
 The size of tag
 The default integer


Dead band
 The threshold (percentage) 

of  difference between the 

current and last published 

value.


Textbox




248

Custom connector can send data which collected by WebAccess/SCADA via MQTT or HTTP to 

the third party service. Also, that can receive control message via MQTT from the service. The 

transfer message is defined freely by no-code user interface on web in JOSN format for 

compatible with the service. It reduces much development effort for third party to connect data 

between SCADA and their self-hosting service.


Select SCADA Node in Org Chart -> Open Connector options -> Select Custom MQTT/HTTP 

Connector.


5.17 Custom MQTT/HTTP Connector


5.17.1 Entry


5.17.2 Custom MQTT/HTTP Connector Configuration

5.17.2.1 Connection Setting
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Click Setup Connector if you never set the connector.


Click Edit if you already set the connector.


Basic Information


●

●

- Editing the Connection Setting


●
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Setting properties:


Status: To enable or disable the connection. (Default: Enable)


Type: The protocol of connection. (Default: HTTP)


Device ID: Identity with a unique string.


Setting for HTTP Only:


POST URL: The URL of the third party service.


Setting for MQTT Only:


IP Address: The IP or domain name of MQTT broker.


Port: Port number of MQTT broker. (Default: 0)


Protocol: TCP(TCP)/TCP Secure(TLS)/Websocket(WS)/Websocket Secure(WSS) connection 

type. (Default: TCP)


Topic Data: MQTT topic defined for sending data from SCADA to third party service.


Topic Control: MQTT topic defined for receiving control message from third party service.


UserName: login user to MQTT broker.


●

●

●

●

●

●

●

●

●

●
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Password: login password to MQTT borker.





 


HTTP Header


HTTP header fields are components of the header section of request messages in the HTTP. 

Only for HTTP.


Connection setting properties:


Header: The field name of HTTP header.


Descriptor: The field value of HTTP header and pairs to Header.


Advanced Settings


●

Note - You can use the reserved word “${wadevid}” in POST URL, Topic Data and Topic 

Control as Device ID property.

●

●

●

●
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Setting properties:


Time Format: Time stamp format definition for transfer data. (Default: ISO 8601)


Golang Time Format: Define the format of time in transfer data with golang way. This field is 

required if the Time Format is Golang Format. Reference: 

https://programming.guide/go/format-parse-string-time-date-example.html and 

https://golang.org/src/time/format.go


Time Zone: Determine the time zone in transfer data. (Default: Local)


Tag Mapping List


●

●

●

●

https://programming.guide/go/format-parse-string-time-date-example.html
https://golang.org/src/time/format.go
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Setting properties:


Tag State: This value is going to replace the reserved word “watagstate” that is the value of 

tag status if the status of tag is the same.


Tag Type: This value is going to replace the reserved word “watagtype” that is the value of 

tag type if the type of tag is the same.


●

●

5.17.2.2 Whitelist Group
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Click Create Whitelist Group if there hasn't any whitelist group.


Click the Triangle at the right of the name of whitelist group and press Edit.


●

●

- Editing the group information
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Group ID: The unique ID of the tag group.


Group Name: Identify the group and show in the top of tabs.


Scan Interval (Millisecond): Collect data interval from SCADA. Tags Data Publish by Value 

Changed is Yes. (Default: 1000)


Publish Interval (Millisecond): Publish data interval to service. Tags Data Publish by Value 

Changed is No. (Default: 1000)


Tags Data Publish by Value Changed: A Boolean attribute to determine the way to send data. 

Select “Yes” means send data to the third party service when value changed. Select “No” 

means to send data to the third party service by data publish time interval, no matter the 

data value changed or not.(Default: Yes)


The white-list link is found on the top side of the SCADA node setting. Using WebAccess cloud 

white-list, users can configure the tag on the ground project.


You can search the selected tag:


●

●

●

●

●

- Editing the white list


●
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Select the node type (via the left menu)


Click the device name -> the tag lists of each device is display the right screen -> Modify 

the whitelist attribute


●

●
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The user can set the tag property in the cloud white-list, and the cloud whitelist has 

configurable properties including dead band and upload. The tag can upload to the cloud 

project by setting the white-list. The following parameters appear for a cloud white-list 

configuration:





The cloud white-list properties


Note - You can select all tags in the specific attribute by checking the checkbox in the column 

title.

Select All:

●

Note – The selected column is the “upload” property. If you want to update the tag to the 

cloud device, the checkbox of the first column must be checked

●
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Then download the SCADA node and start the kernel.


Clicked Edit.


5.17.2.3 Parameter Key


●

- Editing Parameter Key


Property Name
 Description
 Type


Tag Type
 The type of tag
 The default  string


Tag name
 Tag name
 The default  string


Array Size
 The size of tag
 The default integer


Upload
 Enabling to uploading to the  

cloud


Checkbox


Is Trigger Tag
 Enabling to trigger tag
 Checkbox


Dead band
 The threshold (percentage) 

of  difference between the 

current and last published 

value.


Textbox
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Setting properties:


Key Code: Key Code is a field name you defined.


Key Pair: Key Pair is a field value pair for Key Code. Indicate tag value with "${ }", ex: 

${workID}, "workID" is a tag name in WebAccess/SCADA.


JOSN Format helps you set the format of transfer data. The Reserved Word and the Parameter 

Key are used for converting to the transfer data.


●

●

5.25.2.4 JSON Format
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Click Setup JSON Format if you never set the JSON format.


Click Edit if you already set the JSON format.


●

●

- Edit JSON Format
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Format Help


The left panel is the sample format and the right panel is the result that is converted from the 

formatting. You can use the Copy button for pasting up the formatting content in Editor.


●
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Setting properties:


Editor: To type the JSON format here. Press the Check Format button for confirming and 

beautifying the content.


Reserved Word: The key words are about configuration. The reserved word you click is going 

to paste in Editor content.


Parameter Key List: The key words that you set at the function is named parameter key. The 

parameter key you click is going to paste in Editor content.





The preview content is send data that is converted from the Editor content.


●

●

●

Note – The reserved word “wadatafmt” stands for the format of send data. The reserved word 

“wacmdfmt” stands for the format of receive data. The important thing is to make sure the 

reserved word “wadevid” is in command format or Topic Control content.

- Preview Transfer Data
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5.16.1 Configure Video


1. Select your Project and the SCADA Node.


2. Click More classification on node bar, then select Video.


3. You will see the  Video List.


4. Click Insert .


5. The Video configuration page appears


.


5.18 Video
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6. Enter a Video Name that will appear in Dialog Boxes used by operators and users. 


7. Enter a Description that will appear in the project manager.


8. Local Tag File. Optionally, screen tags can be associated with the Video. These are a Local 

Tag file configured DRAW.  These allow a screen script to use Local Tags for rotating 

between video cameras or other customization.


9. Local Script File. Optionally, screen scripts developed in the script editor of DRAW can be 

used to rotate between video cameras or other customization.
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a. On Entry is a screen script that executes once when the Video Display is called in VIEW.


b. On Exit is a screen script that executes once another Display is called and this display is 

exited.


c. While Showing is a screen script that executes continuously at the specified Interval 

while this Display is displayed in VIEW.


d. Interval is the frequency the While Showing Script repeats.


10. Select the Video Type from the Pull down list.  The Video type matches the camera you are 

connecting to.  These correspond to Active X controls supplied by the camera manufacturer. 

 If your camera's manufacturer is not listed on the pull-down list, it is not supported by 

Advantech WebAccess/SCADA. Some are multi-purpose Video Types: snapshot (JPEG pull), 

server push (JPEG Image push). Most are pre-configured to a demo camera on the Internet.


11. Port Number.  Enter the TCP port assigned to the camera.  0 (zero) is the default port 

number for most cameras.  TCP ports are used with firewalls and enhanced security.


12. Press submit.


13. Download to the SCADA node.


Key Mapping for applies to all graphic displays, all VIEW clients and all ViewDAQ is implemented 

from the Key Mapping link on SCADA node properties.


5.19 Key Mapping
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1. Select your Project and the SCADA Node.


2. Click More classification on node bar, then select Key Mapping.


3. You will see the  Key Mapping List.


4. Click Insert New Key Mapping.


5. The Key Mapping configuration page appears.


5.19.1 Configure Key Mapping
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6. Select the Key from the pull down list next to Key Template. In the example, select the UP 

key (the arrow up on most keyboards).


7. Select the Key Mapping from the pull down list next to Key Template. Alternatively, you can 

type the the Key Macro command in this field. In the example enter: <GOTO>GRAPH= 

MAIN.BGR .


about  Key Template :


<FLICKBT> is for Flick down to up gesture. This example means the N7CON1 tag will 

change to 0 when users make the  “Flick down to up” gesture.


<FLICKLBRT> is for the “Flick down to up” gesture.The example means the N7CON1 tag 

will change to 1 when users make the “Flick –lower left to upper right” gesture.

●

○

○



268

7. Optionally, add a description that will remind you and others of the function.


8. Press Submit when done.


9. There are two ways to download these changes to the SCADA Node:


Download and Restart the SCADA node from the SCADA Node properties page.  If you 

have never downloaded the SCADA node before, then this is required. This will 

temporarily stop the SCADA node (if it is running).


Use the Download hyperlink on the Key Mapping List Page. This will download changes 

to the Key Mapping without stopping the SCADA node.


If a local key mapping table is defined, both local and global key mapping will be performed. To 

turn off/on local or global key mapping functions for each individual View/ViewDAQ, please set 

○

○

Gestures
 Keycodes


Flick  – Up to down
 <FLICKTB>


Flick  –upper right to lower left
 <FLICKRTLB>


Flick  – right to left
 <FLICKRL>


Flick  –lower right to upper left
 <FLICKRBLT>


Flick  – Down to Up
 <FLICKBT>


Flick  –lower left to upper right
 <FLICKLBRT>


Flick  – left to right
 <FLICKLR>


Flick  –upper left to lower right
 <FLICKLTRB>


Two-finger  Tap
 <TAP2F>


Three-finger  Tap
 <TAP3F>


Four-finger  Tap
 <TAP4F>


Five-finger  Tap
 <TAP5F>


Three-finger  Grab
 <GRAB3F>


Four-finger  Grab
 <GRAB4F>


Five-finger  Grab
 <GRAB5F>


Three-finger  Spread
 <RGRAB3F>


Four-finger  Spread
 <RGRAB4F>


Five-finger  Spread
 <RGRAB5F>


https://www.yuque.com/__workers/webaccess-scada/user/project-management/2.3.6_Download_and_Start_the_SCADA_Node.htm
https://www.yuque.com/__workers/webaccess-scada/user/project-management/3.2_SCADA_Node_Properties.htm
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%DKEYMAPFILE (local) or %DKEYMAPPING (global) to 0/1.


10. You can use edit or delete on the Key Mapping List.


The Scheduler in Advantech WebAccess/SCADA provides on/off control and setpoint changes 

based on time-of-day, day of week and the calendar. 


 


The scheduler can turn lights on and off, lower or raise the temperature at night or during the 

work day, set temperature to normal levels during each work day, reduce temperature to save 

energy during unoccupied periods, cycle equipment for load balancing, etc.


 


The typical use of the Scheduler is in Building Automation, where Lights, Fans, and HVAC 

equipment are turned on and off based on the time of day and day week.  The Scheduler is also 

used in process control and manufacturing applications.


 


An unlimited number of Circuit Groups and Equipment Groups (i.e. Zone Controls) can be 

programmed each with its own unique schedule.  Multiple Circuits and Equipment Groups can 

also share a schedule.


 


The Scheduler runs on the SCADA Node (or redundant SCADA Nodes).


Select SCADA Node in Org Chart -> Open More options -> Select Scheduler.


5.20 Scheduler


5.20.1 Entry


5.20.2 Overview of Scheduler Functions




270

The scheduler can provide both "On/Off" and Setpoint changes. For example, an "OFF" hours 

Temperature Setpoint may be "setback" during evening hours to save energy while the "ON" 

hours Temperature Setpoint may be set for occupant comfort. The On Value and Off value are 

specified for each Tag (or Circuit). These can be any two values (i.e. not just 0 and 1) to allow 

setpoint changes and other value changes (included text strings). 


The On Values and Off Values are specified for each tag in the Circuit Group.  A tag can be 

viewed as representing a single electrical circuit (for example on/off control of lights).  Hence, 

groups of tags are called "Circuit Groups".  A "Circuit Group" can be any group of tags (or even 

a single tag) that will always share the same schedule.


The Time specifies the Start Time and Stop Time for each day of the Week. Each day of a 

schedule consists of Normal Hours, two sets of  Extra Hours and a Default time 

period.   Separate Start and Stop Time can be defined for Normal Hours, Extra Hours I and Extra 

Hours II.  The Default applies to any time outside of Normal or Extra Hours. The Normal Hours, 

and Extra Hours, combined with the "Default", allows 4 time periods per day (minimum) to be 

specified.  Additional schedules can be defined if more "periods" per day are required.


A Cycle Time, in 1-minute intervals, can also be specified to allow On/OFF cycling of equipment 

during the schedule (for example, turn the Fans on for 10 minutes, then off for 20 minutes from 

8:00 am to 5:00 pm). The ON CYCLE TIME and OFF CYCLE TIME can be defined for each 

Normal, Extra Hours and default period of the day. If both ON Cycle = 0 and OFF Cycle=0, then 

nothing happens, the tags remain unchanged during the time period.  If ON Cycle=1 and OFF 

Cycle=0, then no cycling happens and the tags are set to the ON values for the duration of the 

Start to Stop time.


Holiday defines calendar-based events.  It allows "Holiday Schedules" to be set to account for 

non-occupancy or special events. The Holiday schedule can be used for any calendar event 

(based on Month, Day of Month and Year) up to 1 year in the future.  Multiple holiday schedules 

can be configured and assigned to different groups of tags.


There is no limit to the number of Schedules that can be configured. Each schedule has a START 

TIME, STOP TIME, optional CYCLE time, ON and OFF values for each day of week plus the 

"Holiday schedule".


An Equipment Group associates a Time Schedule with one or more Circuit Groups . Multiple 

"Circuit Groups" can be linked to a single "Time Schedule" in an "Equipment Group".  For 

example, the lights for each floor a building might be grouped into a Circuit group each 

(1stFloorCircuit, 2ndFloorCircuit, 3rdFloorCircuit, … 40thFloorCircuit). Each 'Occupied" floor 

might be assigned to the "Occupied Equipment Group" with the "Occupied Schedule".  If a 
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tenant moves, that floor would be reassigned to the "Unoccupied" Equipment group, which uses 

the "Unoccupied Schedule".


A MANUAL ON and MANUAL OFF feature allow a schedule to be "overridden" and forced to the 

ON or OFF values for a Circuit Group.  MANUAL ON/OFF is typically used to enable occupancy 

(i.e. turn on the lights) for non-scheduled events. AUTOMATIC follows the defined schedule 

when specified in a Circuit Group.


New schedules and changes to schedules will Download to the SCADA node without stopping 

the SCADA Node.


Power Users can download and Modify Schedules from VIEW (and ViewDAQ)  from the Tools 

menu.  Web browser VIEW clients must be log in as  Power Users to Download or Modify a 

Schedule.  Any ViewDAQ user can download a schedule.


To access Scheduler from VIEW:Right Click -> Tools -> Scheduler


To access Scheduler from ViewDAQ:


From the Menu Bar select Tools -> Scheduler


or a pushbutton can be built using <GOTO>tool=bwsch.uti


The usual steps to build a set of schedules are:


1. Define Holiday Schedules to handle exceptions to the 7 days per week schedule. The 

"Holiday" is any unusual event or series of events. The Holiday Schedule can be defined, 

redefined and assigned at any time, but usually is defined first to allow easy assignment to 

the Time Schedules as the "exception" to the schedule.


2. Define the Time Schedules.  These are the START TIME and STOP TIME for Normal  and 

Extra Hours for a weekly schedule. A single "Holiday Schedule Group" is assigned to each 

Time Schedule.


3. Define Equipment Groups. One or multiple Circuit Groups and a single Time Schedule are 

assigned to each Equipment Group. Equipment Groups are groups of Circuits that frequently 

share the same Time Schedule. 


4. Define Circuit Groups.  These are "Tags" that will always share the same Schedule.


5. Download the Schedules to the SCADA node.  You can download the SCHEDULER without 

stopping the SCADA node. The new schedule will take effect immediately.  If a tag is 

supposed to be ON, it will be set to the ON value.


5.20.3 Scheduler Configuration
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Project Users can add, modify and download Schedules from the Project Manager. 


Power Users can add, modify and download Schedules from VIEW.


The Holiday schedule can be used for any calendar event or series of events, based on Month, 

Day of Month and Year, up to 1 year in the future.  Multiple holiday schedules can be configured 

and assigned to different groups of tags.


The typical use is to create "Holiday" schedules to account for non-occupancy of buildings in 

order to have an "exception" to the normal weekday schedule.  A Holiday Schedule can be 

created for any calendar event, not just holidays, that are based on the Day, Month and Year.


Holidays and exceptions to normal schedule are shown in BLUE. Single-click on a date to add / 

remove it as a "holiday".


Group List (Holiday) -  is a List of all configured Holidays.


5.20.3.1 Holiday


●
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Group Number (Holiday) - the user defined number for the Holiday Schedule. Entering a 

New number, not already specified, will create a new Holiday Schedule Group.  Entering a 

number of an existing group will try to overwrite or update that Holiday Group.


Group Name (Holiday) - the user defined Name for this Holiday Schedule.


Insert (Holiday) - creates a new blank Holiday Schedule Group.


Submit (Holiday) - Saves without downloading the currently displayed Holiday Schedule 

Group, as the group number specified in Group Number. If that Group number does not 

already exist, this will create a new Holiday Schedule.  If that group number does exist, it will 

try to overwrite the existing group with this Holiday Schedule and description.


Save and Download to SCADA Node – Saves this Holiday schedule and downloads this and 

all other changes to Scheduler (including saved changes to Equipment Groups, Circuit 

Groups and Time Groups).


You can create a very large number of Holiday Schedule Groups.  For example, if you have 

multiple clients in a high rise building, they may each have their own holiday schedule.

Each Time Schedule has one Holiday Schedule Group assigned to it. This Holiday Schedule 

becomes the "exception" to the normal weekday schedule defined in each Time Schedule.  The 

same Holiday Schedule can be assigned to multiple Time Schedules.


It's probably best to start out with one Holiday Schedule, than as you find exceptions to that 

Holiday Schedule, create new holiday schedules and assign those the Time Schedules that 

require a different exception Schedule.


The Time Schedule specifies the Start Time and Stop Time for each day of the Week. There is 

no limit to the number of Schedules that can be configured. Each schedule has a START TIME, 

STOP TIME, Normal Hours, two sets of Extra Hours, and optional CYCLE time for each day of 

week plus the "Holiday schedule".  The same Time Schedule can be assigned to multiple 

Equipment Groups.


You can build an unlimited number of Time Schedule Groups.  For example, if you have multiple 

clients in a high rise building, they may each have their own Time schedule.


It's probably best to start out with one or two Time Schedules; then as you find exceptions, 

create new Time Schedules as needed. For each new Time Schedule you create, you will 

probably need to create a new Equipment Groups in order to assign that new Time Schedule to 

the desired Circuit Group(s).


●

●

●

●

●

5.20.3.2 Time
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Time Period - Each day of a schedule consist of Normal Hours time period, two sets 

of  Extra Hours time periods and a Default time period.  The Normal Hours, Extra Hours and 

Extra Hours II , combined with the "Default", allows 4 time periods per day (minimum) to be 

specified.


Normal - is any user defined Time period.  Usually it is associated with normal business 

hours.


Extra Hours I - is any user defined Time period.  Usually it is associated with after normal 

work hours. It is equivalent to Normal; it is a second time period that can be defined.


Extra Hours II - is any user defined Time period.  Usually it is associated with after normal 

work hours. It is equivalent to Normal; it is a third time period that can be defined.


Default - applies to any time outside of Normal, Extra Hours I or Extra Hours II.


Start - defines the beginning of each time period: Normal Hours, Extra Hours I and Extra 

Hours II.  The time can be specified in 5-minute intervals. If both Start=0:00 and Stop=0:00 

no action is taken and the period (its undefined).


Stop - defines the end of each time period: Normal Hours, Extra Hours I and Extra Hours 

II.  The time can be specified in 5-minute intervals. If both Start=0:00 and Stop=0:00 no 

action is taken and the period (its undefined).


Cycle ON - specifies an "ON Cycle Time", in 1-minute intervals, to allow On/OFF cycling of 

equipment during the schedule (for example, turn the Fans on for 10 minutes, then off for 20 

minutes from 8:00 am to 5:00 pm). The ON CYCLE TIME can be defined for each Normal, 

Extra Hours and default period of the day.  For any non-zero value of ON Cycle, if OFF 

Cycle=0, no cycling occurs. If ON Cycle=1 and OFF Cycle=0, then no cycling happens and 

the tags are set to the ON values once at the Start Time and set to OFF value ONCE at the 

Stop time.


●

●

●

●

●

●

●

●
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If both ON Cycle = 0 and OFF Cycle=0, then nothing happens, the tags remain unchanged 

during the time period. If ON Cycle=5 and Off Cycle=10, then the equipment will cycle from ON 

to OFF every 15 minutes: 5 minutes ON and 10 minutes OFF.


Cycle OFF - specifies a "OFF Cycle Time", in 1-minute intervals, to allow On/OFF cycling of 

equipment during the schedule (for example, turn the Fans on for 10 minutes, then off for 20 

minutes from 8:00 am to 5:00 pm). The OFF CYCLE TIME can be defined for each Normal, 

Extra Hours and default period of the day.


If both ON Cycle = 0 and OFF Cycle=0, then nothing happens, the tags remain unchanged 

during the time period.  For any non-zero value of OFF Cycle, if ON Cycle=0, no cycling occurs. 

If ON Cycle=1 and OFF Cycle=0, then no cycling happens and the tags are set to the ON values 

once at the Start Time and set to OFF value ONCE at the Stop time. If ON Cycle=5 and Off 

Cycle=10, then the equipment will cycle from ON to OFF every 15 minutes: 5 minutes ON and 10 

minutes OFF.


Group List (Time Schedule) - a list of all configured Time Schedules.


Group Number (Time Schedule) -  the user defined number for the Time Schedule. Entering 

a New number, not already specified, will create a new Time Schedule Group.  Entering a 

number of an existing group will try to overwrite or update that Time Schedule.


Group Name (Time Schedule) - - the user defined Name for this Time Schedule.


Holiday Group -  Lists all Holiday Groups and assigns a "Holiday Schedule" to this Time 

Schedule.  Each Time Schedule has one Holiday Schedule Group assigned to it. This Holiday 

Schedule becomes the "exception" to the normal weekday schedule defined in each Time 

Schedule.  The same Holiday Schedule can be assigned to multiple Time 

Schedules.  "Holiday Schedules" are used commonly to account for non-occupancy or 

special events. The Holiday schedule can be used for any event based on Month, Day of 

Month and Year, up to 1 year in the future. 


Submit (Time Schedule) - Saves the currently displayed Time Schedule as the specified 

Group Number.  If that Group number does not already exist, this will create a new Time 

Schedule.  If that group number does exist, it will try to overwrite the existing group with this 

Time Schedule and description.


Save and Download to SCADA Node – Saves this Time schedule and downloads this and all 

other changes to Scheduler (including saved changes to Equipment Groups, Circuit Groups 

and Holiday Schedule).


A "Circuit Group" can be any group of tags (or even a single tag) that will always share the same 

schedule. A "Circuit" typically is all the On/OFF relays for the Lights in a given area of the plant.


Multiple "Circuit Groups" can be linked to a single "Time Schedule" in an "Equipment 

Group".   Circuit Groups are easily moved from one Equipment Group to another, thereby 

●

●

●

●

●

●

●

5.20.3.3 Circuit Group
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changing the Time Schedule that applies to the Circuit Group.


For example, the lights for each floor a building might be grouped into a Circuit group each 

(1stFloorCircuit, 2ndFloorCircuit, 3rdFloorCircuit, … 40thFloorCircuit). Each "Occupied" floor 

might be assigned to the "Occupied Equipment Group" with the "Occupied Schedule".  If a 

tenant moves, that floor would be reassigned to the "Unoccupied" Equipment group, which uses 

the "Unoccupied Schedule".


Max Tags All Groups - this is the maximum number of Tags that can be specified in any 

Circuit Group. This applies to all circuit groups. You can change this at any time.  Making 

this larger than necessary will increase file sizes and download times. You can not change 

this to less than the number of tags in any existing Groups.


Tag List – provides a pull down menu of tag names for easy data entry. Click the fields 

listed under Tag Name, then open the Tag List by clicking on it.  Scroll down to find the tag 

name. Click once on the tag name to enter it into the selected tag name field.


Tag Name - this column lists the Tags associated with this Circuit group.  A tag can be any 

Analog, Discrete or Text IO Tag, Constant or Calculation Tag.


On Value - is the value the Tag will be changed to at the Start Time if ON Cycle or OFF 

Cycle is non-zero for the time period.  Applies to Normal, Extra Hours I, Extra Hours II and 

Default time periods.  ON Value can be an analog, discrete or text value. ON Value for a 

temperature setpoint is any analog value (e.g. 72 ).  ON Value for a Text value can be any 

●

●

●

●
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text string. ON Value for a Digital is usually "1". Digital and Discrete tags must be set to an 

integer value between 0 and 7 (you can not use the state descriptor for discrete tags).


Off Value  -  is the value the Tag will be changed to at the Stop Time if ON Cycle or OFF 

Cycle is non-zero for the time period.  Applies to Normal, Extra Hours I, Extra Hours II and 

Default time periods.  OFF Value can be an analog, discrete or text value. OFF Value for a 

temperature setpoint is any analog value (e.g. 68 ).  OFF Value for a Text value can be any 

text string. OFF Value for a Digital is usually "0". Digital and Discrete tags must be set to an 

integer value between 0 and 7 (you can not use the state descriptor for discrete tags).


Circuit Group List - a list of all configured Circuit Groups.


Circuit Group Number  -  the user defined number for the Circuit Group. Entering a New 

number, not already specified, will create a new Circuit Group.  Entering a number of an 

existing group will try to over-write or update that Circuit Group.


Circuit Group Name - the user defined Name for this Circuit Group.


Equipment Group -  Lists all Equipment Groups and assigns this Circuit Group to the 

specified Equipment Group.   


Workday Mode - specifies the Monday through Sunday schedule mode as either Automatic 

or Manual.  This allows the schedule for the circuit group to be overridden, disabled or 

enabled.  MANUAL ON/OFF means all tags will be manually set by an operator using the 

"Download to SCADA Node" button.  Manual ON/OFF is typically used to enable occupancy 

(i.e. turn on the lights) for non-scheduled events and to disable automatic scheduling.


AUTOMATIC - follows the defined schedule when specified in a Circuit Group.


MANUAL ON - forces all tags in this Circuit Group to their ON Value at the next 

Download to SCADA Node. The schedule will be ignored and disabled until reset to 

automatic.


MANUAL OFF - forces all tags to their OFF Value at the next Download to SCADA Node. 

The schedule will be ignored and disabled until reset to automatic.


If the MANUAL ON/OFF is temporary, it is recommended to change the Mode back to 

automatic, and submit the change, after the download.  Every Download to SCADA Node will 

enforce all Manual ON and Manual OFF settings for all Circuit Groups.


Holiday Mode - specifies the Holiday schedule mode as either Automatic or Manual.  allows 

the schedule for the circuit group to be overridden, disabled or enabled.  MANUAL ON/OFF 

means all tags will be manually set by an operator using the "Download to SCADA Node" 

button.  Manual ON/OFF is typically used to enable occupancy (i.e. turn on the lights) for 

non-scheduled events and to disable automatic scheduling.


AUTOMATIC - follows the defined schedule when specified in a Circuit Group.


MANUAL ON - forces all tags in this Circuit Group to their ON Value at the next 

Download to SCADA Node. The schedule will be ignored and disabled until reset to 

automatic.


MANUAL OFF - forces all tags to their OFF Value at the next Download to SCADA Node. 

The schedule will be ignored and disabled until reset to automatic.


●

●

●

●

●

●

○

○

○

●

○

○

○



278

If the MANUAL ON/OFF is temporary, it is recommended to change the Mode back to 

automatic, and submit the change, after the download.  Every Download to SCADA Node will 

enforce all Manual ON and Manual OFF settings for all Circuit Groups.


Delete (Circuit Group) - deletes specified Circuit Group, specified in Group Number.


Submit (Circuit Group) - Saves the currently displayed Circuit Group as the specified Group 

Number.  If that Group number does not already exist, this will create a new Circuit Group.  If 

that group number does exist, it will try to over-write the existing group with the displayed 

Tags, On Values, Off Values, Modes and description.


Save and Download to SCADA Node – Saves this Circuit Group and downloads this and all 

other changes to Scheduler (including saved changes to Holiday Schedule, Equipment 

Groups and Time Groups).


Equipment Groups associate one or multiple Circuit Groups with a Time Schedule.  Equipment 

Groups allow a single Time Schedule to be assigned to multiple Circuit Groups quickly and 

reduces the need to re-create the same schedule.


The philosophy in designing an Equipment Groups is to view an Equipment Groups as Tags 

(Circuits) that frequently share the same Time Schedule.  In contrast, Circuit Groups are best 

viewed as Tags that "always" share the same schedule.


An example of multiple "Circuit Groups" linked to a single "Time Schedule" in an "Equipment 

Group" are, the lights for each floor a multi-story building.   The Lights of each Floor might be 

grouped into a Circuit group each (1stFloorCircuit, 2ndFloorCircuit, 3rdFloorCircuit, … 

40thFloorCircuit). Each "Occupied" floor might be assigned to the "Occupied Equipment Group" 

with the "Occupied Schedule".  If a tenant moves, that floor would be reassigned to the 

"Unoccupied" Equipment group, which uses the "Unoccupied Schedule".


Group List (Equipment Group) - a list of all configured Equipment Groups.


Group Number  (Equipment Group) -  the user defined number for the Equipment Group. 

●

●

●

5.20.3.4 Equipment Group


●

●



279

Entering a New number, not already specified, will create a new Equipment Group.  Entering 

a number of an existing group will try to over-write or update that Equipment Group.


Group Name - the user defined Name for this Equipment Group.


Time Group -  The most important feature.  Assigns a Time Schedule to all the Circuit 

Groups Listed in this Equipment Groups. Also lists  all configured Time Schedules (Time 

Groups).


Circuit Group - Lists all Circuit Groups assigned to this Time Group.  Note that you assign 

Circuit Groups to a Time Group from the Circuit Group Configuration page.


Delete (Equipment Group) - deletes specified Equipment Group, specified in Group Number.


Submit (Equipment Group) - Saves the currently displayed Equipment Group as the 

specified Group Number.  If that Group number does not already exist, this will create a new 

Equipment Group.  If that group number does exist, it will try to over-write the existing 

group with displayed Time Group and Name.


Save and Download to SCADA Node – Saves this Equipment Group and downloads this and 

all other changes to Scheduler (including saved changes to Holiday Schedule, Circuit Groups 

and Time Groups).


Schedules can be created, edited and downloaded from:


the Project org chart (Project Users and admin)


VIEW (Power Users and admin)


ViewDAQ


1. Login in to Project org chart


2. Select SCADA Node


3. From More drop down list, select Scheduler.


●

●

●

●

●

●

5.20.3.5 Create or Modify a Schedule


●

●

●

- Start Scheduler in Org chart
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1. Login as a Power User or Admin.


2. Right Click -> Tools -> Scheduler


1. From the Menu Bar, select Tools -> Scheduler


- Start Scheduler in View or ViewDAQ


Start Scheduler from VIEW:


Start  Scheduler from ViewDAQ:
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1. Start Scheduler from Project Manager, VIEW or ViewDAQ.


2. From the Holiday page, create at least one holiday schedule. It can be blank.  The  Holiday 

Schedule defines “exceptions” to the 7 day per week schedule. The "Holiday" is any unusual 

event or series of events. The Holiday Schedule can be defined, redefined and assigned at 

any time, but usually is defined first to allow easy assignment to the Time Schedules as the 

"exception" to the schedule.


a. Enter a name for the Holiday Schedule.


b. Enter a Group Number.

c. Press submit.


3. Select Time.


4. On the Time Group page, define the Time Schedules.  These are the START TIME and STOP 

TIME for Normal and Extra Hours for a weekly schedule. A single "Holiday Schedule Group" 

is assigned to each Time Schedule.


a. Enter a Time Group Number.


b. Enter a name the Time Group.


c. From pull down list, select Holiday Schedule.


  d. Under Normal Hours, use the pull down list to select Start and Stop times  (Monday 

through Sunday and Holiday).


  e. Enter 1 under Cycle ON and leave 0 as Cycle Off if value is continuously ON.


  f. Repeat for Extra Hours, Extra Hours II and default cycle if there are multiple scheduled 

per day. (See Time for more detailed information)


  g. Press submit.


5. Select Equipment Group.


- Create a Schedule
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6. Define Equipment Groups by:


a. Enter Group Number


b. Enter a Name


c. Select a Time Group (a Schedule) from the pull down menu.


d. Press submit.


7. Select Circuit Group


8. Define Circuit Groups.  These are "Tags" that will always share the same Schedule.


a. Enter a Name for the Circuit Group.


b. Accept 0 or enter a Circuit Group Number.


c. Select an Equipment Group from the pull down menu.  The Equipment Group associates 

a Time Group (a Schedule) with this Circuit and, optionally, the same time 

group/schedule with other circuits.


d. Select Tags.

e. Click the add bar at the bottom of tag list.


f. To increase the number of tags, modify the Max Tags field.


g. Press submit.


9. Download the Schedules to the SCADA node.  You can download the SCHEDULER without 

stopping the SCADA node. The new schedule will take effect immediately.  If a tag is 

supposed to be ON, it will be set to the ON value.


A  Power User can Down Load Schedules from VIEW (the web browser).


A Project User can Down Load Schedules from the Project Manager (web browser).


Any user can download schedules from ViewDAQ.


Schedule changes will Download to SCADA Node without stopping the SCADA node. This can be 

done from any configuration page in the Scheduler (Time, Equipment, and Circuit Group).


A dialog box prompts to confirm the Download Schedule to SCADA Node.  All "submitted" 

changes made to the scheduler are downloaded.


All Manual ON or Manual OFF states are also downloaded.


To Download a change to the SCADA node from Project Manager:


5.20.3.6 Download to SCADA Node (Scheduler)


 - Download Schedule from Project Manager
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1. Login to Project Manager


2. Select SCADA Node in Project org chart.


3. Select Scheduler from SCADA Node main page.


4. Make the desired change in Holiday, Time, Circuit Group, or Equipment Group.


5. Press the "Submit" button


6. Click on Download to SCADA Node.


7. Select OK at the prompt to Download Scheduler.


Power Users can download and Modify Schedules from VIEW (and ViewDAQ) from the Tools 

menu.  Web browser VIEW clients must be logged in as a Project Users to Download or Modify a 

Schedule.  Any ViewDAQ user can download a schedule.


To access Scheduler from VIEW:


Right Click -> Tools -> Scheduler


To access Scheduler from ViewDAQ:


From the Menu Bar, select Tools -> Scheduler


Or a pushbutton can be built using <GOTO>tool=bwsch.uti


Schedule changes will Download to SCADA Node without stopping the SCADA node. This can be 

done from any configuration page in the Scheduler (Time, Equipment, and Circuit Group).


A dialog box prompts to confirm the Download Schedule to SCADA Node.  All "submitted" 

changes made to the scheduler are downloaded.


All Manual ON or Manual OFF states are also downloaded.


 


To Download a change to the SCADA node from Project Manager:


1. Make the desired change in Time, Holiday, Equipment or Circuit Group.


2. Press the "Submit" button


3. Click on Download to SCADA Node.


4. Select OK at the prompt to Download Scheduler


 - Download Schedule from VIEW


5.20.4 Overview of Classroom Scheduler Functions
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The Classroom Scheduler is a licensed option.  It allows the definition of up to 16 periods per 

day.


If the SCADA Node has the license, then the Classroom Scheduler shows in the Right Click -> Tools 

menu in VIEW below the Scheduler.


The scheduler can provide both "On/Off" and Setpoint changes.  For example, an "OFF" hours 

Temperature Setpoint may be "setback" during evening hours to save energy while the "ON" hours 

Temperature Setpoint may be set for occupant comfort. The On Value and Off value are specified for 

each Tag (or Circuit). These can be any two values (i.e. not just 0 and 1) to allow setpoint changes and 

other value changes (included text strings). 
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The On Values and Off Values are specified for each tag in the Circuit Group.  A tag can be viewed as 

representing a  single electrical circuit (for example on/off control of lights).  Hence, groups of tags 

are called "Circuit Groups".  A "Circuit Group" can be any group of tags (or even a single tag) that 

will always share the same schedule.


The Time specifies the Start Time and Stop Time for each period of the day, up to 16 periods. (Note 

that the standard Scheduler allows only time 4 periods per day).    


Class Setting enables the ON setting if  the time period is set to YES (orange color).  If the class 

setting is NO (green color) , then the OFF value is used.


Holiday defines calendar-based events.  It allows "Holiday Schedules" to be set to account for non-

occupancy or special events. The Holiday schedule can be used for any calendar event (based on 

Month, Day of Month and Year) up to 1 year in the future.  The OFF value is used for Holidays in the 

CLassroom Scheduler (unlike the Scheduler).


An Equipment Group associates a Time Group with one or more Circuit Groups . Multiple "Circuit 

Groups" can be linked to a single "Time Schedule" in an "Equipment Group".  For example, the lights 

for each floor a building might be grouped into a Circuit group each (1stFloorCircuit, 2ndFloorCircuit, 

3rdFloorCircuit, … 40thFloorCircuit). Each 'Occupied" floor might be assigned to the "Occupied 

Equipment Group" with the "Occupied Schedule".  If a tenant moves, that floor would be reassigned to 

the "Unoccupied" Equipment group, which uses the "Unoccupied Schedule".


A MANUAL ON and MANUAL OFF feature allow a schedule to be "overridden" and forced to the ON or 

OFF values for a Circuit Group.  MANUAL ON/OFF is typically used to enable occupancy (i.e. turn on 

the lights) for non-scheduled events. AUTOMATIC follows the defined schedule when specified in a 

Circuit Group.


New schedules and changes to schedules will Download to the SCADA node without stopping the 

SCADA Node.


Power Users can download and Modify Schedules from VIEW (and ViewDAQ)  from the Tools 

menu.  Web browser VIEW clients must be log in as  Power Users to Download or Modify a 

Schedule.  Any ViewDAQ user can download a schedule.


To access Scheduler from VIEW:Right Click -> Tools -> Classroom Scheduler


To access Scheduler from ViewDAQ:


From the Menu Bar select Tools -> Classroom Scheduler
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The Class Number and Time Class Number and Time The number of Time Periods in the Days of 

the week.  And it defines the Start Time and Stop Time of each classroom period.  Up to 16 

classroom periods can be defined.  They apply to all days of the week.


Class Setting is used to set the Occupancy (Yes or No) during each period. The these periods 

where defined in the Class Number and Time Class Number and Time. Class Setting enables 

the ON setting if  the time period is set to YES (orange color).  If the class setting 

is NO (green color) , then the OFF value is used.


The Recipe File is a group of recipes and Units associated with those recipes.  This is an 

organizational feature.  You can group all of your recipes into a single recipe file or spread them 

5.20.4.1 Class Number and Time


5.20.4.2 Class Setting


5.21 Recipe
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over multiple recipe files.  The recipe file consists of a specific file downloaded to the hard drive 

of the SCADA node.


All the "units" and "recipes" within a given recipe file must have the same number of "items".


1. Select your Project and the SCADA Node.


2. Click More classification on node bar, then select Recipe.


3. You will see the  Recipe List.


4. Select Insert Recipe File.


5. The Recipe  configuration page appears.


5.21.1 Configure Recipe
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6. Recipe File Name. Enter a name that will appear in dialog boxes and displays in run-time 

View.


7. Tolerance. Enter a numeric value (in % of full scale) that will generate a recipe error after 

download. Tolerance is in % of full scale (SpanHi - SpanLo).   A zero value means that the 

tag must match the preset exactly.  Tolerance is used to account for the variation in the 

representation of numbers in the field device (e.g. 12-bit devices), the accuracy of IO and 

the conversion to/from engineering units.  For example, if you download a 1.9 to some 

devices, round-off or other representation errors will result in a 2.0 reported.


8. Edit Security. Enter the Area and Level required of a User to change a preset value in this 

recipe.  Read Only prevents all users from changing the preset values in a recipe.  Read Only 

allows users and operators to download the recipe, but not edit it. This applies to all recipes 

in this recipe file.


9. Download Security.  Enter the Area and Level required of a User to download this recipe to 

field device. This applies to all recipes in this recipe file.


10. Unit Name.   The Unit can be any name, but usually corresponds to a physical device (for 

example MixTank1, MixTank2, MixTank3 etc.) Equipment Lineup and Process Unit are other 
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terms for Unit.   The Unit will consist of a group of tags.  When Operators or Users select the 

Unit in Run-time, the Tags to be downloaded will change to those associated with this 

unit.   There can be multiple units assigned to the same recipe file allowing the same recipe 

to be used by different groups of tags. By defining multiple Units, the same recipe can be 

downloaded to different groups of tags by operators and users.  In selecting a recipe, 

operators select the recipe and unit to download.


11. Recipe Name.  A recipe is a group of Preset Values.  This allows dozens or hundreds of tags 

to be changed with a single button push. These can be numbers or text. Operators and users 

during run-time will select the desired recipe to download.  A recipe contains the list or pre-

set values defined by an engineer that will be downloaded using a single button 

push.  Multiple recipes are the most common usage. For example, if you are mixing paint, 

each recipe might represent a different color of paint.  The Pre-set Values will the  amounts 

of each component color used to make the final color.


12. Item Name. Enter a descriptive name to help understand the tags in the recipe.  Item names 

are usually ingredient names.  Tag names are usually structured (like FI101:SP).  Item Names 

are usually descriptive (Flour, Water, Blue Dye, Red Dye, etc).  The item names remain the 

same for all recipes in a recipe file.  The tag names will change depending on the Unit 

selected.  The pre-set values will change depending on the Recipe selected.


13. Tag Name. These are the physical IO tags that are associated with this recipe process 

Unit.  For example, if the Unit is Tank1, then all the tags would normally be IO tags 

associated with Tank1 in the field. These can be Analog, Discrete or Text tags, IO tags, 

Block Tags, Constant Tags even calculation or accumulation tags.  For Block tags, the full 

name must be specified (Blockname : parameter).


14. Tag List. Tag Names can be selected from a Pull Down List or typed.


15. Submit.  Press submit to enter the data changes. Press cancel to abort any changes.  Delete 

will delete the entire recipe file including all units and all recipes in that file.


16. There are two ways to download these changes to the SCADA Node (this will not download 

to the PLC or field device):


a. Download and Restart the SCADA node from the SCADA Node properties page.  If you 

have never downloaded the SCADA node before, then this is required. This will 

temporarily stop the SCADA node (if it is running).


b. Use the Download hyperlink on the Recipe List Page. This will download changes to the 

Recipe without stopping the SCADA node


c. Tag List. The items in the recipes and units in this recipe file. To add more Items to your 

recipe, click ADD button.


To add another Recipe Name or Unit Name to a Recipe File, just type a new Name for the Recipe 

or Unit and click add icon then click "Done".  This will actually make a copy of the original Unit 

5.21.2 Configure or copy a Unit or Recipe Name
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or Recipe that was selected. 


For a new Unit, edit the Tag Names.


For a new Recipe Name, edit the Preset Values.


Remember to press "Submit" when you are done.


You actually make a copy of the Unit or Recipe Name with the new name.  Just select the Unit or 

Recipe, type a new name and click add icon then click "Done".


You can Delete Unit Name or Recipe Name from the Unit Recipe List or the Recipe Recipe List 

if you want to remove the old Unit or Recipe Name from Recipe Lists.


To Delete a Unit or a Recipe from a Recipe File, select the Recipe from Recipe List then select 

Unit Names or Recipe Names and click the remove bar at the bottom of the list.


5.21.3 Rename a Unit or Recipe Name


5.21.4 Delete a Unit or Recipe
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You will be given a list of each Unit in every Recipe File or a list of Each Recipe Name in every 

Recipe File.


This section assumes you have already created the BLOCKS and TAGS you plan to add to your 

Faceplate Groups and Overview Group Displays.  You can type in the Tag Names and Block 

Names of tags and blocks you plan to build.


This section assumes you have started Internet Explorer web browser and connected to your 

Project Node.


Select your Node on Org chart.


5.22 Faceplate

5.22.1 Add Faceplate Group


●
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Select Faceplate. The Faceplate Group List Page appears.


Select Insert Faceplate.

 


The Create Faceplate Dialog appears.


●

●

●
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Enter a Unique Group Number (between 1 and 1000). This is how the Group will be ordered in 

the Faceplate Group Dialog Box in View and the Position on the Overview Display Group.


Enter a Description for the group.  This will appear in the Faceplate Group List Dialog Box 

seen by users and operators in VIEW.


Tag List (Figure 5-30) shows the names of all Analog Tags and Discrete Tags. Lists both 

Blocks and Tags


Select the Block Name or Tag Name desired then click the add bar at the bottom of the list. 

The Block or Tag name should appear on the Block List.


You can Type Tag names and Blocks.  You can also copy and paste Tag Names and Block 

Names from the Right List of dialog card (be sure to type block name with parameter).


If you want to enter a Block, type only the Block Name.  For example, enter TIC101. This will 

show all parameters for the block.





Click Submit when you are finished.


●

●

●

●

●

Note - If you enter the full Blockname:parameter, only that one parameter would appear. For 

example entering TIC101:MEAS would not show the other parameters for the block TIC101.

●
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This section assumes you have already created the BLOCKS and TAGS you plan to add to your 

Faceplate Groups and Overview Group Displays.  You can type in the Tag Names and Block 

Names of tags and blocks you plan to build.


This section assumes you have started Internet Explorer web browser and connected to your 

Project Node.


Select your Node on Org chart.


Select Faceplate. The Faceplate Group List Page appears.


Select Edit of the Faceplate Group you want to modify.


The Update Faceplate Group dialog opens.


5.22.2 Modify a Faceplate Group


●

●

●

●
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Tag List (Figure 5-30) shows the names of all Analog Tags and Discrete Tags. Lists both 

Blocks and Tags.


Seletct the Block Name or Tagname desired then click the add bar at the bottom of the list. 

The Block or Tag name should appear on the Block List.


You can Type Tag names and Blocks.  You can also copy and paste Tag Names and Block 

Names from the Right List of dialog card (be sure to type block name with parameter).


If you want to enter a Block, type only the Block Name.  For example, enter TIC101. This will 

show all parameters for the block.





 


Press Submit when finished making changes to your Faceplate Group.


●

●

●

Note - If you enter the full Blockname:parameter, only that one parameter would appear. For 

example entering TIC101:MEAS would not show the other parameters for the block TIC101.

●

5.23 EXCEL IN & EXCEL OUT


https://www.yuque.com/__workers/webaccess-scada/user/project-management/5.5.3_Add_Faceplate_Group.htm#_Ref26619177
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The database export and import to EXCEL (EXCEL IN and EXCEL OUT) allow users to modify 

Tags and Blocks in EXCEL using copy, paste, edit and other EXCEL tools.


The EXCEL OUT function is used to transfer Tag and Block configuration information to an 

EXCEL Spreadsheet.  EXCEL OUT exports all the Tags and Blocks for one SCADA Node to an 

EXCEL workbook. After exporting the SCADA Node's Tag database, you can modify the Tags 

and Blocks by editing the entries or creating additional records (rows).


EXCEL IN imports the modified Tag database back into any SCADA Node in any Advantech 

WebAccess/SCADA  Project.


The most common use of EXCEL is to copy and paste recurring values to a group of tags (for 

example, copy DEGF as the EUNIT for all Temperature Tags).


The recommended method of using an EXCEL spreadsheet to edit tags is to first configure tags 

(and or Blocks) using the standard Advantech WebAccess/SCADA ASP pages.  These will act as 

"templates" that you can export to EXCEL (EXCEL OUT).


Users can add new Tags and Blocks by copying existing tags or blocks, inserting the copied 

rows, then editing the copy to make unique tag and block names.  The address must also be 

changed to match the actual address in the field device.


Note also that each EXCEL worksheet has a limit of 65,536 rows (i.e. tags). If your database is 

large, and any one tag-type exceeds 65,000 (e.g. analog tags exceed 65,000) on one SCADA 

Node, you might consider working on the Access database directly.


EXCEL IN and EXCEL OUT export and import to the PROJECT NODE.  You can initiate EXCEL 

import/output from any client, but the EXCEL spreadsheet will be created on the Project 

Node.  If you are working from a client, you can download the EXCEL workbook (spreadsheet) 

using your web browser. To download the EXCEL spreadsheet (workbook) to a client, open a 

Web Browser and entering the IP address of the Project Node with the broadweb/excel path and 

the name of the Excel workbook you created.  For example, to download from the Live Demo the 

bwCfgExport.XLS, type:


http://www.advantech.com.cn/eAutomation/WebAccess/index.asp


If you are working from a Client, and would like to copy the modified EXCEL workbook back to 

the Project Node, you will need access to a shared folder on the project node or FTP should be 

enabled on the project node with privileges to write to the ftp server. Then, you could use EXCEL 

IN, browse to the shared folder or FTP server's folder and import the EXCEL spreadsheet using 

EXCEL IN.  EXCEL 97 and EXCEL 2000 are supported by the EXCEL import functions.


EXCEL IN requires the Project Name and SCADA Node name match the target project and 

node. You must rename the Project and SCADA Node columns in all the sheets (BwAnalog, 

BwDiscrete, BwAlarmAnalog, etc.) if you are copying a node to a new node name or project. 


When importing tags to a SCADA Node, the Comport and Device specified must already exist in 

the target  Node Configuration, EXCEL IN imports only Tags and Blocks, it does not create 

SCADA Nodes, comports or devices.


CAUTION: BACKUP your PROJECT BEFORE using EXCEL IN! Importing a database to a 

Advantech WebAccess/SCADA project will overwrite the configuration data in the original 
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project's SCADA Node. Before you import data to an existing database, be sure you backup your 

database so that you have the option to restore the database to its original form if required.


 


When you export, you can define any name and path for your EXCEL Workbook (i.e. 

spreadsheet).  Advantech WebAccess/SCADA will create a new Workbook with spread sheets 

named: BwAnalog, BwDiscrete, BwText, BwCalcAnalog, BwCalcDiscrete, BwAcc. 

BwAlarmAnalog and BwAlarmDiscrete.   The utility also creates three blank spreadsheets, 

sheet1, sheet2, and sheet3 that you can use for any purpose.


BwAnalog - contains all Analog type IO Tags, Analog Block Tags (Parameters) and Constant 

Tags. Analog tags have real numbers as their value (e.g. 100.1,  0.0, 1955).  These are 

distinguished by the "Tag Type" column:


     Tag Type     Description


3                  Constant Tag - analog type


6                  IO Tag - analog type


b                  Block Tag Parameter - analog type


Constant Tags usually have a blank address fields.


BwDiscrete - contains all Discrete type IO Tags, Discrete Block Tags (Parameters) and Discrete 

Constant Tags. Discrete tags have integers as their value (0 to 7).  Digital tags (ON / OFF, 

True/False, 0/1) are considered discrete.  These are distinguished by the "Tag Type" column:


     Tag Type     Description


4                  Constant Tag - discrete type


7                  IO Tag - discrete type


b                  Block Tag Parameter  - discrete type


Constant Tags usually have a blank address fields.


 


BwText - contains all Text type IO Tags, Text Block Tags (Parameters) and Text Constant Tags. 

Text tags have text strings as their value (e.g. ASCII strings).       Tag Type     Description


5                  Constant Tag - text type


8                  IO Tag - text type


b                  Block Tag Parameter  - text type


Constant Tags usually have a blank address fields.


 


BwCalcAnalog - contains all Analog-type Calculation Tags. Analog tags have real numbers as 

their output value.


BwCalcDiscrete - contains all Discrete-type Calculation Tags. Discrete tags have integers as 

their output value (0 to 7).  Digital tags (ON / OFF, True/False, 0/1) are considered discrete. 


BwAcc - contains all Accumulation Tags.


BwAlarmAnalog - contains all Alarms for Analog-type tags. The corresponding tag must exist in 

one of the BwAnalog, BwCalcAnalog or BwAcc worksheets.
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BwAlarmDiscrete  - contains all Alarms for Discrete-type Tags. The corresponding tag must 

exist in either the BwDiscrete or BwCalcDiscrete worksheets.


If you use the default path and filename for EXCEL OUT, Advantech WebAccess/SCADA copies 

the previous EXCEL spreadsheet that was exported to the backup folder on the Project Node.


To simplify the process of configuring a Advantech WebAccess/SCADA database, you can use 

EXCEL IN to export the Tag database to EXCEL, edit the exported file and import it back to any 

Advantech WebAccess/SCADA project.


Importing data can only be done if there are valid worksheet names with valid column names. 

Typically, data is first exported from Advantech WebAccess/SCADA to an external spreadsheet 

to create the appropriate worksheets and columns. The data can then be imported back into 

Advantech WebAccess/SCADA.


EXCEL IN -  imports Tags from EXCEL Spreadsheet.  EXCEL IN allows tags to be imported into 

the Project or another project.


It is recommended to create tags only by copying tags already exported using EXCEL OUT.


EXCEL IN imports an EXCEL Worksheet on the Project Node.  You must be on the Project Node 

or the Project Node must have access to a Shared Drive to import this EXCEL Worksheet.


The Project Name and SCADA Node name for the Tags you want to import from the Worksheet 

must match the Project and SCADA node you are importing to.


To import Tags from EXCEL


1. Select your Project and SCADA Node.


2. Click Insert classification on node bar, then select Excel-In.


3. Optionally modify the path and file name of the EXCEL Worksheet. (note - this must be 

located on the Project Node).


5.23.1 EXCEL IN Example
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4. Select No if you want only to insert new tags without overwriting existing tags.


5. Press Submit.


6. A page appears listing Tags imported from Excel.
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7. Optionally, Print the list.


8. Press Done when finished.


The new tags should appear in the Project Under your SCADA node.


 An entire Column was pasted.  This will create 65,535 rows of mostly empty data and will 

result in a very long time to import via EXCEL IN.  The web server may timeout resulting in no 

imported tags.     


B.  File name is not correct.  


C.   The original EXCEL OUT saves as bwTagExport.  It will be overwritten the next time 

EXCEL Out is used and will erase your work


D. The worksheet is on the Project Node.  If you are on a remote client or remote SCADA 

node, you will not be able to see the exported worksheet.  Contact your system administrator 

to Map a network drive or have an FTP service set up on the Project node that you can 

access.


E. The Project or SCADA node name in the EXCEL spreadsheet does not match the Project 

or SCADA Node you are importing to.


F. The leading Apostrophe ( '  or single quote) )is omitted from a cell or multiple cells.  On 

newer versions of EXCEL ODBC driver (EXCEL 2000 and later) you can correct this problem 

by formatting the cells with the missing Apostrophe (') as Text.


Format -> Cells -> Number Tab -> Text.


The page of the EXCEL IN expects data to be formatted as text, including numbers. The leading 

apostrophe and Format -> Cells -> Text both are interpreted by the ODBC driver a text.


EXCEL OUT -  exports the Tag Database of a SCADA node to an EXCEL Spreadsheet on the 

SCADA node, to allow editing of the tags and adding new tags by copying existing tags.  EXCEL 

IN allows those changes to be imported into the Project or another project.


It is recommended to create tags only by copying tags already exported using EXCEL OUT.


EXCEL OUT creates a EXCEL Worksheet on the Project Node.  You must be on the Project Node 

or have access to a Shared Drive or an FTP directory on the Project Node to edit this EXCEL 

Worksheet.


To export Tags to EXCEL


1. Select your Project and SCADA Node.


2. Click Export classification on node bar, then select Export to Excel.


Common Errors


●

●

●

●

●

●

5.23.2 EXCEL OUT Example
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3. Optionally modify the path and file name of the EXCEL Worksheet. (note - this will be 

located on the Project Node)


4. Press Submit.


5. A page appears listing Tags exported to Excel.
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6. Optionally, Print the list.


7. Press Done when finished.


Open EXCEL on the Project Node to edit the file named in step 3 above


Select WISE-PaaS Dashboard on platform.





6. WISE-PaaS/Dashboard

6.1 Login
6.1.1 Login on Home Page


Note - This option is available when WISE-PaaS Dashboard is installed.
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Enter your account and password, then choose Project name.


If you want to remember your account on your browser, please tick the Remember me option.
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The option SRP Name is a function that can help you login to  WIESE-PaaS Dashboard SRP-

Frame page directly. After selecting <None>SRP-Frame name and logging in, the page will be 

directed to WIESE-PaaS Dashboard page. Otherwise, the page will be directed to the SRP-

Frame you selected.


Before using this feature, you must first configure it in WebAccess Project Management / 

Setting / Dashboard SRP Frame Setting. The SRP name list will appear when you select the 

corresponding project name.


Click Monitor icon which in project block you want to login on Project List page.


6.1.2 Login on Project List Page
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Select WISE-PaaS Dashboard in the drop down list.





It will use the current account and the project to login WISE-PaaS Dashboard.


The WISE-PaaS Dashboard user has three role: server admin, org admin and org viewer.


Only the WebAccess admin owns server admin role.


This role can do everything to every organization. For example:


Add & Edit data sources.


Add & Edit Dashboard.


Switch organization.


Configure Server Admin Settings.


Only the WebAccess power user owns org admin role.


Note: This options is available when WISE-PaaS Dashboard is installed.

6.2 User Management


6.2.1 Server Admin


●

●

●

●

6.2.2 Org Admin
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This role can do everything to this project name organization. For example:


Add & Edit data sources.


Add & Edit Dashboard.


The WebAccess general and restricted user owns org viewer role.


View any dashboard on this project name organization.


Cannot create or edit dashboards nor data sources.


The WebAccess Data Source Plugin will auto setting when you login WISE-PaaS Dashboard.


You can only setting WebAccess port by yourself.


Note: The org admin user belongs only to the project that created it.

●

●

6.2.3 Org Viewer


●

●

6.3 Data Source


6.3.1 Data Source Settings
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Select default data source in metrics tab in panel.


The data source has two data type: timeserie and table. Different data type has different data 

source.


6.3.2 How to use Data Source


6.3.2.1 Timeserie


6.3.2.1.1 Real Time Trend
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Tag Name: Target tag.


Display Name: Display name in panel.


Tag Name: Target tag.


Data Type: Lasy, Min, Max, Avg


Display Name: Display name in panel.


●

●

6.3.2.1.2 Data Log


●

●

●

6.3.2.1.3 Tag Value
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Tag Name: Target tag.





Display Name: Display name in panel.


Tag Name: Target tag.





Display Name: Display name in panel.


●

Note: It can be a array or field value.

●

6.3.2.1.4 Tag Value Text


●

Note: It can be a array or field value.

●

6.3.2.2 Table


6.3.2.2.1 Action Log
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Node Name: SCADA Node Name


Node Name: SCADA Node Name


●

6.3.2.2.2 Alarm Log


●

6.3.2.2.3 Alarm Summary
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Disable Alarm Priorities: Filter AlarmPriority column. Use ﻿,﻿ and ﻿-﻿ select filter priorities.


Because different data type returns different data structure, each data type can only compatible 

with specific plugin.

The compatiblity of each data type shows below.


●

6.3.2.2.4 Constraint
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Graph can use Real Time Trend, Data Log data source.


Table can use Action Log, Alarm Log and Alarm Summary data source.


Singlestat can use Tag Value and Tag Value Text data source.


Control Panel can use Tag Value and Tag Value Text data source.


Control Panel can set value to specify tag.


*1: Control Panel can set value to WebAccess. It need specific data source for different tag 

type.

6.4 Dashboard Panel

6.4.1 Graph


6.4.2 Table


6.4.3 Singlestat


6.4.4 Control


Panel
 Real 

Time 

Trend


Data Log
 Tag 

Value


Tag 

Value 

Text


Action 

Log


Alarm 

Log


Alarm 

Summary


Graph
 ✓
 ✓


Table
 ✓
 ✓
 ✓


Singlesta

t


✓
 ✓


Control*

1


✓(Analog

, 

Discrete)


✓(Text)


Alarm 

Summary


✓
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Input value you want to change. Click Submit.


Alarm Summary Panel is only for alarm summary data source.


Row column color changed by ack status.


Alarm: red


To normal: green


Acked: original color


Buttons


Acknowledge all button: Acknowledge all tags in this project.


ACK button in every rows(except ACKed rows): Acknowledge the specific tag.


https://portal-technical.wise-paas.com/doc/document-portal.html#Dashboard-1


6.4.5 Alarm Summary


●

○

○

○

●

○

○

6.5 Reference Document


7. WISE-PaaS/SaaS Composer


https://portal-technical.wise-paas.com/doc/document-portal.html#Dashboard-1
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Select SaaS Composer on platform.





Enter your account and password, then choose Project name.


If you want to remember your account on your browser, please tick the Remember me option.


7.1 Login
7.1.1 Login on Home Page


Note - This option is available when SaaS Composer is installed.
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Click Monitor icon which in project block you want to login on Project List page.


Select SaaS Composer in the drop down list.





It will use the current account and the project to login SaaS Composer.


WebAccess Administrator and Power User can add / modify / view sketchboards.


WebAccess General and Restricted User can only view sketchboards.


The WebAccess Data Source plugin will be auto set and can not be modified.


7.1.2 Login on Project List Page


Note: This options is available when SaaS Composer is installed.

7.2 User Management

●

●

7.3 Data Source
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https://portal-technical.wise-paas.com/doc/document-portal.html#SaaSComposer-1


7.4 Reference Document


https://portal-technical.wise-paas.com/doc/document-portal.html#SaaSComposer-1
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